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Overview
X-Author for Excel addresses two key areas for using Excel and Salesforce together.
For Salesforce applications like CRM, Apttus CPQ or other custom applications. X-Author
lets you use Microsoft Excel natively as a user interface (UI) for tasks that need Excel rather than a
browser UI. You can use a new or existing spreadsheet to connect to Salesforce, or you can
launch a spreadsheet directly from within Salesforce. X-Author for Excel can accommodate many
formats (not just grids), simultaneously use multiple objects, and access data that is spread across
multiple worksheets, and make use of powerful query capabilities.
For traditional stand-alone spreadsheets. In many companies, there are hundreds of thousands
of spreadsheets. In these companies, people route spreadsheets through email and shared drives.
This means you do not always know who has the latest version. If worksheets are cut and pasted
into other spreadsheets, it takes a lot of time to get properly consolidated reporting, and integrity is
often questionable. For these use cases, consider having some or all the data in these
spreadsheets housed in Salesforce. With X-Author, you can retain the Microsoft Excel UI and
formats, but the data is instantly available in the Salesforce cloud for easy enterprise control,
reporting, and routing. Because X-Author centralizes the Microsoft Excel templates in Salesforce,
you can create and enforce security and version control over the data even though it is being used
in Microsoft Excel.
In both cases, you can use just the Microsoft Excel UI and the data will move between Excel and
Salesforce. If you still need the actual Microsoft Excel file for audit purposes—or perhaps because
it contains more data than you want to store in Salesforce—X-Author offers file check-in and checkout capabilities to provide centralized control.

About this Guide
This guide is for X-Author for Excel designer users who are responsible for developing apps for
runtime users. You can begin at the "Getting Started" section and work your way through the guide
to learn how to build a complete, well-designed app or jump to any section in the guide for help on
a specific topic.
Included in the X-Author for Excel Designer guide:
Information for Admins on installation, licensing and permissions for both Runtime and
Designer users of X-Author for Excel.
9
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An overview of Apps and how to get started creating your first app.
Step-by-step instruction for building Quick Apps, including examples.
Detailed instructions on how to create apps quickly and easily using X-Author for Excel
Designer.
Advanced features for creating complex apps, like Matrix Maps and External Actions.
Detailed use cases for each part of the app design process.
Information on migrating your applications from one Salesforce org to another, including
how to use the Data Migration Wizard to create automated migration apps.
How to launch apps directly from Salesforce.
How to configure apps for Presto.
Continue to the next section for installation details or skip ahead to Getting Started with X-Author
for Excel.

10
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Installing X-Author for Excel
The following table summarizes the components required to install and begin working with XAuthor for Excel. Refer to the most recent X-Author for Excel Release Notes for the current
versions.
Component

Type

Notes

Apttus X-Author for Excel
(Apttus_XApps / Runtime).

Salesforce
Managed
Package

This package must be installed first.

Apttus X-Author Designer for
Excel (Apttus_XAppsDS /
Designer).

Salesforce
Managed
Package

X-Author for Excel Add-in:
Designer + Runtime

Microsoft
Excel Addin

This add-in allows you to work with the X-Author
Excel and X-Author Designer tabs in Microsoft
Excel.

X-Author for Excel Add-in:
Runtime Only

Microsoft
Excel Addin

This add-in allows you to work with the X-Author
Excel tab in Microsoft Excel (Runtime users).

The following packages are optional and may be required in addition to the above
components based on your license or licenses.
Apttus X-Author for Excel
(Admin)

Salesforce
Managed
Package

Required for Power Admin licenses or the legacy
Data Migration product.

Apttus Document Generation

Salesforce
Managed
Package

Required for X-Author Presto licenses. This
package must be installed first.

11
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Component

Type

Notes

Apttus X-Author for Excel
Document Generation

Salesforce
Managed
Package

Required for X-Author Presto licenses.

Salesforce Package Licenses
The following table describes the minimum Salesforce package licenses required for specific XAuthor roles. For detailed information on required X-Author licenses and permissions, refer to
Getting Started with X-Author for Excel.
Role

Salesforce Packages Licensed

Runtime
User

X-Author for Excel

Designer

X-Author for Excel, X-Author Designer for Excel

Power
Admin

X-Author for Excel, X-Author Designer for Excel, X-Author for Excel (Power
Admin)

Presto User

X-Author for Excel, Document Generation, X-Author for Excel Document
Generation

To enable licenses
After you install the X-Author for Excel Salesforce packages, you must send your Org ID to Apttus.
By default, when X-Author for Excel is installed, the lowest level of license is provisioned. After
Apttus has upgraded functionality in your environments, take the following steps to enable XAuthor functionality according to your license:
1. Log in to Salesforce.
2. Click on the Apttus X-Author for Excel tab.

12
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3. Click Refresh License.

All users connecting to X-Author for Excel are now able to use licensed product features.

Installing the X-Author for Excel Add-in
The installation process creates a folder on your computer that contains the files required to use
both the X-Author Designer and the X-Author for Excel tabs in Excel. Depending on the version of
Windows you are using, the folder is created either in your Program Files or Program Files (x86)
directory.
For Designers, install the X-Author Designer + Runtime Add-in for Microsoft Excel.
For Runtime Users, install the X-Author for Excel: Runtime Only version.

Refer to the most recent X-Author for Excel Release Notes for the correct version of the
add-in to install.

Installation Requirements
Your computer must meet the minimum requirements listed below.

The Mac OS X operating system is not supported; however X-Author can be used on a
Mac that is running a Windows Virtual Machine in a VMWare or Parallels environment.

13
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Component

Requirement

Microsoft

Microsoft Excel 2010 (32 bit & 64 bit), Microsoft Excel 2013 (32 bit & 64 bit),
Microsoft Excel 2016 (32 bit & 64 bit)

Microsoft

Microsoft .NET Framework 4.5

Microsoft

Microsoft Visual Studio 2010 Tools for Office Runtime

Microsoft

Microsoft Office 2010 Primary Interop Assemblies

Salesforce

Any Salesforce edition that provides API support for the Salesforce objects that
will be accessed in an X-Author for Excel App.

Before you install the X-Author add-in:
You must be connected to the Internet.
You must have access to the add-in executable file.
You must have Administrator permissions on the computer being used for the install.
You must close all instances of Microsoft Excel.

To Install the X-Author Add-in
1. Double-click the installer executable to display the InstallShield Wizard. In rare instances, a

restart of Windows may be required. Click Yes to confirm the restart. After you log in to
Windows, the installer automatically resumes.
2. Click Next to start the wizard.
3. On the License Agreement screen, select I Accept and click Next. If you do not accept the

terms of the agreement, X-Author will not be installed on your computer.
4. Click Install to begin the installation process. If any components need to be installed for X-

Author to work as expected, they will be automatically detected as missing and installed. If
components are required but cannot be accessed through the Internet, an appropriate
message will be displayed and the installation will need to be completed after all missing
components have been manually installed.
5. Click Finish to close the wizard and complete the installation.
14

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform
6. Open Microsoft Excel.

Designers: The X-Author Designer and X-Author for Excel ribbon tab should be available in
Excel. If the ribbon tab is not displayed, you may need to register X-Author Designer or X-Author
for Excel with Excel.

Runtime Users: The X-Author for Excel ribbon tab should be available in Excel.

Showing Disabled X-Author Add-in Tabs
X-Author for Excel provides the utility Show X-Author Tabs.exe to re-enable the X-Author add-in in
Microsoft Excel after errors have disabled it. This ensures that the add-in will always be enabled
when opening Excel after the utility is run. When you install X-Author for Excel, the diagnostic utility
is installed in the same directory. A shortcut for Show X-Author Tabs.exe is also created on the
desktop.

You must to have administrator rights in the system where you want to run the diagnostic tool.

Registering the X-Author Add-in
In rare cases, the X-Author Designer or X-Author for Excel tabs are not properly installed and,
therefore, are not visible in your Microsoft Excel ribbon menu. If this occurs, you must manually
register the X-Author add-in to add it to the Excel ribbon.

15
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To manually register the Add-In
1. Start Excel and select File > Options to display the Excel Options dialog.
2. Click Add-Ins, select COM Add-ins from the Manage list, and click Go.
3. Select the Apttus X-Author Designer and X-Author for Excel check boxes and click OK.

The add-ins are now available in the Excel ribbon. You may need to restart Excel for the tabs to
display as expected.

Enabling Proxy Authentication
By default, X-Author for Excel will use your Microsoft Internet Explorer (IE) proxy settings. Because
the IE settings are used to connect to your Salesforce org, the default configuration will work for XAuthor in most cases. However, if your work environment is behind a firewall and you need to
manually configure proxy authentication to connect to Salesforce, you must complete the
procedure in this section.

Microsoft Internet Explorer Proxy Settings
Proxy server settings in IE are located at Tools > Internet Options > Connections >
LAN Settings. However, the location of the proxy server settings in IE may be different
due to your IE version. Refer to Microsoft IE's documentation for more information.

16
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To enable X-Author for proxy authentication
1. Open Excel and click on either the X-Author Designer or X-Author for Excel tab.

2. From the Access section of the ribbon, click on the arrow under the Support icon and choose

General Settings

3. Under the "Proxy Settings" section, choose one of the options described in the following

table.
Setting

Description

No proxy

Click this radio button if you do not use a proxy connection.

Use system
proxy

Click this radio button to use the Microsoft Internet Options setting to
determine your proxy server settings. If you choose this option, X-Author
will automatically resolve the connection so that you can successfully login
to X-Author and connect to your Salesforce org. This is the default setting.

Manual
proxy
configuration
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Setting

Description
Click this radio button to enter settings for the proxy server you will be
using. If you choose this option, you must enter the address and port
number of your proxy server in the Proxy Address to Use and Port fields,
respectively. If you are required to provide authentication information, click
the Authenticated check box and enter a user name and password in the
provided fields.

4. Click Apply to apply settings and Close to return to X-Author.

Your system proxy settings are now associated with X-Author Designer and will take effect the
next time you log in.

Multi-Language Support
In addition to English, X-Author for Excel is also available in the Japanese (Nihongo) language. XAuthor application support is currently provided for:
Validation Messages
Captions
Labels
Error Messages and warnings
Actual data remains as in your Salesforce org.
You can choose the language to use in X-Author for Excel.
Go to Support > General Settings and set the language preference as English or Japanese. After
changing this option, restart Microsoft Excel.
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Getting Started with X-Author for Excel
This section contains information to help you get started with X-Author for Excel.
Licenses and User Assignment
Setting Salesforce Permissions
Assigning Field-Level Permissions

Licenses and User Assignment
Running or designing apps requires a combination of X-Author licenses and user assignment to
managed Salesforce packages:
Apttus Licenses
One or more X-Author for Excel product editions (for example, X-Author Enterprise or X-Author
Power Admin):
Analytics (formerly "Reporting")
Enterprise
Presto
Power Admin
User Assignment:
X-Author Designer Package—Assignment to this package is required for app designers.
X-Author for Excel Package —Assignment to this package is required for designer and
runtime users who can run any app that has been both activated and assigned to them by a
designer.
Salesforce Licenses
To access Salesforce.com from Microsoft Excel using any X-Author for Excel edition, a user
must have an API-enabled Salesforce.com license to the objects they need to access.

20

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

Setting Salesforce Permissions
Unless they have a System Administrator profile, users will not automatically have access to the
package contents that are required to access X-Author functionality.
To provide access to users, Apttus recommends that administrators create new permission sets for
both Runtime and Designer and assign them to the appropriate users.

As an alternative, you can assign the below permission to user profiles rather than
creating permission sets, if it is more convenient.

To create a permission set for Runtime users
Follow the standard Salesforce steps for creating a permission set and configure the following
settings and permissions. After creating the permission set, assign it to one or more Runtime
users in your org.
Runtime Users
Custom
App
Settings

Apttus X-Author for Excel: Visible

Tab
Settings

X-Author for Excel: Default on

Custom
Object &
Field
Permissions

Permission Sets > Permission Set Overview > Object Settings > Apps

21
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Runtime Users

Permission Sets > Permission Set Overview > Object Settings > App
Assignments
App Assignments: Read & View All
Field Permissions: Read All
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Runtime Users

Permission Sets > Permission Set Overview > Object Settings > App Files
Only required for Check-in/Check-out
App Files: Read / Create / Edit / Delete
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Runtime Users
Field Permissions: Read All, Edit All

Enabled
Apex Class
Access
Enabled
Visualforce
Page
Access

24
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To create a permission set for Designer users
Follow the standard Salesforce steps for creating a permission set and configure the following
settings and permissions. After creating the permission set, assign it to one or more Designer
users in your org.
Designer Users
Custom
App
Settings
Tab
Settings

Apttus X-Author for Excel: Visible

X-Author for Excel: Default on
X-Author Designer: Default on
Apps: Default on (Visible & Available)
App Licenses: Default on (Visible & Available)

Custom
Object &
Field
Permissions

25
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Designer Users
Field Permissions: Read All, Edit All

Permission Sets > Permission Set Overview > Object Settings > App
Assignments
App Assignments: Read / Create / Edit / Delete
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Designer Users
Field Permissions: Read All, Edit All

Permission Sets > Permission Set Overview > Object Settings > App Files
Only required for Check-in/Check-out
App Files: Read / Create / Edit / Delete
Field Permissions: Read All, Edit All
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Designer Users

Enabled
Apex Class
Access
Enabled
Visualforce
Page
Access

Apttus_XApps.AppBuilderWS

Apttus_XApps.SearchSelectAction
Apttus_XApps.Landing
Apttus_XApps.LicenseManager
Apttus_XAppsDS.DesignerInfo
Apttus_XAppsDS.AppAssignmentOverview
Apttus_XAppsDS.AppAssignmentUsers
Apttus_XAppsDS.AppAssignmentProfiles
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Assigning Field-Level Permissions
The Activated and UniqueId fields on the App object must be set to visible. Usually, these
permissions will be set during the installation of the managed package. However, depending on
org-specific security settings, you might need to set these permissions manually.

To set the field-level permissions
1. In Salesforce App Setup, go to Create > Objects > App.
2. Click Custom Fields and Relationships.
3. Click Activated.
4. Click Set Field Level Security.
5. Make sure that the Visible check box is selected for every profile that requires app access.
6. Repeat steps 3 – 5 for the UniqueId custom field definition.
7. Click Save.

Completing Designer Setup
To permit Designers to assign apps they have created to users and use the Launch from
Salesforce feature, a Salesforce admin must add two buttons to the App Page Layout: the Assign
button and the Excel Setup button.

To add the Assign button
1. Go to Setup > App Setup > Create > Objects.
2. Click the App object.
3. Hover over the Page Layouts button (located at the top of the page) and click Edit next to

Application Layout.
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4. In the left panel, click Buttons.
5. If the Assign button is not in the displayed as shown in the following figure, you will need to

add it for designers.

Add the assign button to the layout that leads you to the user profile page.

To add the Excel App Setup button
Designers must have the Excel App Setup button added to their layout on the Apps List view in
order to use the Launch from Salesforce feature.
1. Log in to Salesforce and go to Setup > Create > Objects and click App.
30 2.
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2. From the top of the page, click Search Layouts.

3. Click Edit next to Apps List View and move Excel App Setup to Selected Buttons.

4. Click Save.

For step-by-step instructions on launching an app from Salesforce, refer to
Launching an X-Author for Excel App from Salesforce.
For step-by-step instructions on activating and assigning apps, refer to Activating
and Assigning Apps.

Apttus X-Author for Excel Objects
The following objects contain fields that are maintained in the corresponding tables for the objects.
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X-Author for Excel
Object

Purpose of the Object

App

Apttus X-Author Excel Application

App Assignment

Assignment of X-Author for Excel App to user or profile

App File

Apttus X-Author for Excel™ Application Files for Check-in and CheckOut functionality

Connecting to Salesforce from Excel
Now that you have installed X-Author, you need to open Excel and connect X-Author to your
Salesforce org. You can create connections to multiple Salesforce orgs, switch between orgs
without leaving Excel, and revoke existing connections.
Connecting to Salesforce from Excel
Adding More Connections
Switching Salesforce Connections
Revoking Connections

Connecting to Salesforce from Excel
Use the following process to connect to your Salesforce org.

To connect to Salesforce from X-Author Designer
1. Open Excel.
2. In the X-Author Designer or X-Author for Excel ribbon menu, click Connect.

If this is the first time you have connected to Salesforce, the Manage Connections window
opens.

32
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3. Under the Create a new connection section and in the Name field, enter the Salesforce.com

user name.

If you have previously connected to Salesforce, but need to connect to a different
org, refer to Switching Salesforce Connections.

4. In the Login URL field, type the URL you use to log in to Salesforce (In many cases, the URL

is login.salesforce.com for production orgs and test.salesforce.com for sandboxes. You can
click the shortcut for either of these in the Examples section).
5. Click Authorize. The Salesforce login window opens.
6. Type your username and password in the provided fields and click Log in to Salesforce.

The X-Author Designer ribbon is fully enabled. Now you can start designing an app or using
existing apps.

Adding More Connections
If you use X-Author for Excel with more than one Salesforce org, you can connect to multiple
instances of Salesforce.

To add a Salesforce connection
1. Open Excel.

33
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2. In the X-Author Designer or X-Author for Excel ribbon menu, click Switch Connection and

select Manage Connections. The Manage Connections window opens.

3. Under the Create a New Connection section, enter the Salesforce.com user name.
4. In the Login URL field, type the URL you use to log in to Salesforce (In many cases, the URL

is login.salesforce.com for production orgs and test.salesforce.com for sandboxes. You can
click the shortcut for either of these in the Examples section).
5. Click Authorize. The Salesforce login window opens.
6. Type your username and password in the provided fields and click Log in to Salesforce.

The X-Author Designer ribbon is fully enabled. Now you can start designing an app or using
existing apps.

Switching Salesforce Connections
If you have previously connected to a Salesforce org and now need to connect to a different org,
you will need to switch connections because the connection will default to the org you most
recently connected to. Use the following procedure to switch to a different org.

To switch Salesforce connections
1. In the X-Author Designer or X-Author for Excel ribbon menu, click Switch Connection.
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2. Select a connection from the drop-down menu. The Salesforce login window opens.
3. Type your password and click Log in to Salesforce.

The X-Author Designer ribbon is fully enabled. Now you can start designing an app or using
existing apps.

Revoking Connections
If you no longer need to connect to a Salesforce org, you can revoke the connection. After a
connection is revoked, you will no longer see that connection as an option when switching or
managing connections.

To revoke a Salesforce connection
1. Open Excel.
2. In the X-Author Designer ribbon menu, click Switch Connection and select Manage

Connections. The Manage Connections window opens.
3. Click the Revoke button next to the connection you want to remove. The Revoke Access

confirmation window opens.
4. Click Yes to confirm the action.

The connection is no longer be available in X-Author.

Using the X-Author Designer Ribbon
All of the controls you need to use X-Author Designer are located in the X-Author Designer ribbon
menu in Microsoft Excel.
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Before you start designing apps, you should familiarize yourself with the X-Author for Excel
components that are accessed through the X-Author Designer ribbon menu. Click the link in the
first column to learn more about the component.
Component

Description

Apps

Click this button to create a new app, change the app type, or open an existing
app. (Click the Quick App button to instead create a simple single-object app or a
parent-child-type app.)

Data
Migration

Click this button to create new app using the Data Migration Wizard, or edit an
existing Data Migration app.

Salesforce
Objects

Click this button to specify the Salesforce objects and fields you will use in the
app. (This section only covers single object and parent-child objects.)

Display Map

Click this button to define the associations between Excel spreadsheet cells and
Salesforce fields for the Salesforce data to be retrieved. When data is retrieved
from Salesforce, using one of the X-Author data invoking actions, it is temporarily
stored in Excel memory before being placed into the worksheet. X-Author then
uses a Display Map to place the data in the correct Excel cells.

Matrix Map

Click this button to define a matrix map. Matrix maps extend the capabilities of XAuthor for Excel well beyond list formats. In lists, one Salesforce record is
represented per Excel row or column. Using matrices, a record can be
represented by one or more cells by mapping columns and rows (the X and Y
axes) of a matrix as well as the data contained in the cell at the intersection of the
mapped column and row. Depending on the type of matrix, various data cells can
be updated by a user. If no value exists in a cell, adding a value can create a new
record depending on the matrix design.

Save Map
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Component

Description
Click this button to define relationships between Salesforce fields and Excel cells
for data that will be saved to Salesforce.

Actions

Click this button to assign actions to your app. Actions can be used to retrieve,
display, and save data. They can also automate tasks in Excel worksheets and
call Salesforce methods.

Action Flow

Click this button to define a sequence of one more actions that will be executed
when end users click buttons on the app's ribbon menu.

User Menus

Click this button to create the ribbon menus that your end users will see in the XAuthor for Excel ribbon in Excel.

Save App

Click this button to save or clone your application.

App Settings Click this button to restrict runtime functions (such as saving, printing, rich-text
editing) and password-protect worksheets.
Import

Click this button to import a previously exported app from a different Salesforce
org.
Note: All Salesforce objects used in the source org must also exist in the
destination org.

Export

Click this button to export an app from one Salesforce org for the purpose of
importing it to another.

Sync App

Click this button to identify mismatches and missing objects or fields after any
import or data migration is complete.

Source Data

Click this button to easily migrate data from one Salesforce org to another using XAuthor for Excel.

Preview

Click this button to preview your app in Runtime mode.
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Component

Description

Connect

Click this button to connect to your Salesforce org.

Switch
Connection

Click this button to to switch your connection to another org, add additional
connections, or to revoke a previously configured connection.

External
Library

As an application designer, you can choose to create additional custom actions
apart from the ones provided in the X-Author for Excel executable packages. For
example, you can create a custom action to populate missing External IDs for the
Custom Objects in your org.

38

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

Designing Apps
About Apps and Where They Are Stored
An X-Author for Excel application (app) is created within Microsoft Excel using X-Author Designer.
There is no coding because all configuration is accomplished through the point-and-click designer.
An app is the combination of:
A Microsoft Excel template that contains the Excel workbook layout.
An XML file that contains the app-specific User Menus, Action Flows, maps, and other userexperience elements.
Apps are stored in the applications object within a Salesforce org. Each app is represented by one
application record in which the Microsoft Excel spreadsheet template, an XML file, and other
configuration data are stored in the Notes and Attachments. (These files should not be edited
without using the X-Author Designer or it may corrupt the app.)

X-Author for Excel apps are not related to the Salesforce definition of an application or
app. A single X-Author app can include any number of objects that span any number of
Salesforce applications.

Choosing the Correct App Type
Before you begin designing an app, you need to consider what type of app you want to create.
This will usually be dictated by the type of license you have.
Apps can be created in two ways:
Use the fully featured Designer. When you use the designer, each of the components must
be configured manually (for example, Display Map and Save Map).
Create a Quick app. A Quick app is a 1 – 2 minute wizard experience where a designer can
create a simple single object list on its own (for example, Opportunities) or a list filtered by a
parent object (for example, Opportunities by Account).
To learn how to create a Quick app, refer to Creating apps with Quick apps.
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Note
A third type of app can be created using the Data Migration Wizard. This app is
specifically designed for migrating data between two organizations. For information on
creating a Data Migration app, refer to Using the Data Migration Wizard.

To create an app
1. In the ribbon menu, click the apps button and select New App.

2. Type the app name in the app Name field. This name will display as the window title in the

Excel worksheet at runtime.

Give your app a name that is concise but also summarizes the basic purpose of the
app.
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3. To use a new Excel template, click the New radio button. Although most existing templates

can be used, it is sometimes easier to start with a clean workbook unless users are very
familiar with the existing file and change management is a concern.
4. To create an app from an existing Excel file, click the Existing radio button and then click

Browse to select the template file.
5. Click Next.

6. Select the app edition based on your license and requirements:

Reporting – choose this app type for data retrieval only.
Enterprise – choose this app type for bi-directional movement of data between Excel
and Salesforce. This is the standard app type.
Presto – choose this app type for use cases requiring remote execution of an app.
The runtime user does not open Excel to work with this type of app.
Power Admin – choose this app for use cases requiring data migration between orgs.
This app type enables features to aid in the data migration process.
7. Click Create.
8. In the ribbon menu, click Save App.

You have created an app shell and you are ready to add the various Designer components.

Creating Apps with Quick Apps
Prerequisite
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Before you can create an app, you must connect to a Salesforce org that is configured for
X-Author for Excel. For information on configuring and connecting to Salesforce, refer to
Getting Started with X-Author for Excel and Connecting to Salesforce from Excel.
Use the Quick App wizard when you need to create a simple single object list on its own (for
example, Opportunities) or a list filtered by a parent object (for example, Opportunities by
Account).
The Quick App produces a complete, ready to run app that includes:
Two objects (maximum).
One Display Map, one Save Map, two Action Flows (Data Retrieve and Save), and two User
menus (Retrieve and Save). No additional components are available. The Quick App
functionality equates to the X-Author Essentials license. A Quick App can be edited using
the Quick App editing function but if a Quick App is opened and customized using the full
Designer, it can no longer be an X-Author Essentials app.
Follow the step-by-step instructions in the next two sections to create either a single-object or
parent-child Quick App.
To create a Single Object app
To create a Parent Child app

To create a Single Object app
1. Click Quick App and select New.

The Build a Quick App window opens.
2. Type the application name into the App Name field.

Give your app a name that is concise but also summarizes the basic purpose of the
app.
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3. Click the Single Object List radio button and then click Next. The Build a Quick App page

opens.

4. Click the Object drop-down menu and select a Salesforce object. The Select Fields section

will display the fields associated with the object.
5. Click the check box next to the fields you want to include in your app. ( Notice that the two

primary fields of the object are selected by default. )

You can search for Salesforce fields using the Search Fields search box. Click
Clear to clear the search terms and view the full list.
6. Click Next.
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The Select Field Options window opens, displaying the fields that you selected in the
previous step.
7. Select from the options in the following table.

Column

Description

Data
Criteria

Select the method you would like to use to retrieve data. Query—Select this
method to have the query automatically run, based on your app's
predetermined search filters, and retrieve the data without user intervention.
User Selection—Select this method to allow users to apply search filter criteria
before retrieving data.

Select All
Display
Fields
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Column

Description

Save
Fields

Click this check box to include all object fields in the Save Map.
Note: This check box is inactive unless Display Fields is checked.

Grid Columns
Display

Click this check box to include this field's data in the data retrieved from
Salesforce and displayed in the Excel workbook.

Order

This represents the order, left to right, that fields will be displayed in. Click in the
cell to edit the order.

Save

Click this check box to allow users to change the data in these cells in the Excel
workbook and then save those changes to Salesforce.
Note: Fields that are not Display fields cannot be Save fields.

Search
Fields

Click this check box to add a runtime search filter for this field. These filters will
be used to limit the type of records returned when the runtime user retrieves
data. For example, might make Billing Country a Search field so that you can
retrieve data from only those accounts who have a billing address in Canada.
This field appears only when the Data Criteria is set to User Selection.
Note: You must select at least one field, and ID fields are not searchable.

Result
Fields

Click this check box to display this field in the search results when retrieving
and filtering data from Salesforce. This field appears only when the Data
Criteria is set to User Selection.
Note: You must select at least one field and ID fields cannot be used.

As shown in the following images, the displayed columns will vary based on the Data Criteria
you select.
Selecting Field Options with Query Data Criteria
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Selecting Field Options with User Selection Data Criteria
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8. To add a filter to the data, click Filters.

Complete the fields described in the following table to build your filter.

47

Field

Description

Salesforce
Object
and Field

Click the lookup icon
to select the object and field that you want the filter
to apply to.
Note: You cannot type the field name in the text field.

Value
Type

Select the value type from the drop-down menu. The value types change
based on the Salesforce field or object selected.
• Input—Select this value to allow users to type in a value to search for. For
example, if the field is Account ID, you might choose to let them type or paste
the account ID in the filter at runtime.
• Static—Select this value to prevent users from changing the Value field at
runtime.
• System Variable—Select this value to specify a system variable, such as
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Field

Description
CurrentUser or CurrentDate, as the filter value.
• User Input—Select this value to allow users to change the Value field at
runtime.

Operator

Select a relational operator from the drop-down menu.
• Equals—The field value is equal to the specified value.
• Not equal to—The field value is not equal to the specified value.
• Starts with—The field value begins with the specified value.
• Contains—The field value contains the specified value string.
• Not contains—The field does not contain the specified value string.
• In—The field value is in the specified list of hard-return-separated values.
• Not In—The field value is in the specified list of hard-return-separated
values.

Value

Type the comparison value in this field or select the value from the drop-down
menu. Your options will vary depending on the type of field you are
filtering on.
Click this button to delete a filter row.

Add Row

Click this button to add a new filter row.

Clear All

Click this button to remove all filter rows.

Add Filter
Logic

Click this button to display the Filter Logic field and define the Boolean logic
used to relate filters. For example, you might want display results only when
all of your filter conditions are met or you might want to display results when
any filter conditions are met. You can use filter logic to do this. Filter logic in
X-Author for Excel works the same as it does in Salesforce.com.

9. Click Save.
10. Click Next.
11. On Provide App Settings page, provide requisite information as described in the table.
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Field

Description

Enable App
Launch from
Salesforce

Select this check box to allow users to open this X-Author app from within
the Salesforce application (as well as from within Excel).

Enable Save
for Google
Sheets

Select this check box to allow users to open this X-Author app from within
the Google Sheets application (as well as from within Excel).

Worksheet
Title

Type the title of the Excel worksheet. The title appears in the top row of the
worksheet.

Max Column
Width

Type the maximum width of an Excel column (in characters).

View
Gridlines

Select this check box to display the gridlines in the Excel worksheet.

Display
Filters

Clear this check box if you do not want the filters that you created to
appear in the Excel worksheet.

Group Label

Type the ribbon menu group name. This value appears beneath the
buttons in the X-Author for Excel ribbon tab.

Retrieve
Data Button
Label

Type the text you want to appear on the ribbon menu button used for data
retrieval.

Save Data
Button Label

Type the text you want to appear on the ribbon menu button used for
saving data to the Salesforce database.

Enable Add
Row
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Field

Description
Select this check box to allow users to add rows to the Excel worksheet.
This option could be used to add records to the workbook so those records
can be uploaded to Salesforce.

Enable
Delete Row

Select this check box to allow users to delete rows from the Excel
worksheet.

12. Click Finish.

An App has been created with all design functions complete. You can now Preview the app, run
the app, or use X-Author Designer to make additional modifications.

To create a Parent Child app
1. Click Quick App and select New.

The Build a Quick App window opens.
2. Type the application name into the App Name field.

Give your app a name that is concise but also summarizes the basic purpose of the
app.

3. Click the Parent Child radio button and then click Next. The Build a Quick App page opens.
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4. Click the Object drop-down menu and select a Salesforce object. The Select Fields section

will display the fields associated with the object.
5. Click the check box next to the fields you want to include in your app. ( Notice that the two

primary fields of the object are selected by default)

You can search for Salesforce fields using the Search Fields search box. Click
Clear to clear search terms and view the full list.
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6. Click Next. The Select Field Options window opens, displaying the fields that you selected in

the previous step.

7. Select the Child Object and the fields that you want to include in your app.
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As shown in the following images, the displayed columns will vary based on the Data Criteria
you select.
Selecting Field Options with Query Data Criteria

Selecting Field Options with User Selection Data Criteria
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8. Select from the options in the following table.

Column

Description

Data
Criteria

Select the method you would like to use to retrieve data. Query—Select this
method to have the query automatically run, based on your app's
predetermined search filters, and retrieve the data without user intervention.
User Selection—Select this method to allow users to apply search filter criteria
before retrieving data.

Select All
Display
Fields
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Column

Description

Save
Fields

Click this check box to include all object fields in the Save Map.
Note: This check box is inactive unless Display Fields is checked.

Grid Columns
Display

Click this check box to include this field's data in the data retrieved from
Salesforce and displayed in the Excel workbook.

Order

This represents the order, left to right, that fields will be displayed. Click in the
cell to edit the order.

Save

Click this check box to allow users to change the data in these cells in the Excel
workbook and then save those changes to Salesforce.
Note: Fields that are not Display fields cannot be Save fields.

Search
Fields

Click this check box to add a runtime search filter for this field. These filters will
be used to limit the type of records returned when the runtime user retrieves
data. For example, might make Billing Country a Search field so that you can
retrieve data from only those accounts who have a billing address in Canada.
This field appears only when the Data Criteria is set to User Selection.
Note: You must select at least one field, and ID fields are not searchable.

Result
Fields

Click this check box to display this field in the search results when retrieving
and filtering data from Salesforce. This field appears only when the Data
Criteria is set to User Selection.
Note: You must select at least one field and ID fields cannot be used.

9. To add a filter to the data, click Filters.

Complete the fields described in the following table to build your filter.
Field

Description

Salesforce
Object
and Field
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Field

Description

Click the lookup icon
to select the object and field that you want the filter
to apply to.
Note: You cannot type the field name in the text field.
Value
Type

Select the value type from the drop-down menu. The value types change
based on the Salesforce field or object selected.
• Input—Select this value to allow users to type in a value to search for. For
example, if the field is Account ID, you might choose to let them type or paste
the account ID in the filter at runtime.
• Static—Select this value to prevent users from changing the Value field at
runtime.
• System Variable—Select this value to specify a system variable, such as
CurrentUser or CurrentDate, as the filter value.
• User Input—Select this value to allow users to change the Value field at
runtime.

Operator

Select a relational operator from the drop-down menu.
• Equals—The field value is equal to the specified value.
• Not equal to—The field value is not equal to the specified value.
• Starts with—The field value begins with the specified value.
• Contains—The field value contains the specified value string.
• Not contains—The field does not contain the specified value string.
• In—The field value is in the specified list of hard-return-separated values.
• Not In—The field value is in the specified list of hard-return-separated
values.

Value

Type the comparison value in this field or select the value from the drop-down
menu. Your options will vary depending on the type of field you are
filtering on.
Click this button to delete a filter row.

Add Row
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Field

Description

Clear All

Click this button to remove all filter rows.

Add Filter
Logic

Click this button to display the Filter Logic field and define the Boolean logic
used to relate filters. For example, you might want display results only when
all of your filter conditions are met or you might want to display results when
any filter conditions are met. You can use filter logic to do this. Filter logic in
X-Author for Excel works the same as it does in Salesforce.com.

10. Click Save.
11. Click Next.
12. On Provide App Settings page, provide requisite information as described in the table.
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Field

Description

Enable App
Launch from
Salesforce

Click this check box to allow users to open this X-Author app from within
the Salesforce application (as well as from within Excel).

Enable Save
for Google
Sheets

Select this check box to allow users to open this X-Author app from within
the Google Sheets application (as well as from within Excel).

Worksheet
Title

Type the title of the Excel worksheet. The title appears in the top row of the
worksheet.

Max Column
Width

Type the maximum width of an Excel column (in characters).

View
Gridlines

Select this check box to display the gridlines in the Excel worksheet.

Display
Filters

Clear this check box if you do not want the filters that you created to
appear in the Excel worksheet.
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Field

Description

Group Label

Type the ribbon menu group name. This value appears beneath the
buttons in the X-Author for Excel ribbon tab.

Retrieve
Data Button
Label

Type the text you want to appear on the ribbon menu button used for data
retrieval.

Save Data
Button Label

Type the text you want to appear on the ribbon menu button used for
saving data to the Salesforce database.

Enable Add
Row

Select this check box to allow users to add rows to the Excel worksheet.
This option could be used to add records to the workbook so those records
can be uploaded to Salesforce.

Enable
Delete Row

Select this check box to allow users to delete rows from the Excel
worksheet.

13. Click Finish.

An app has been created with all design functions complete. You can now Preview the app, run
the app, or use X-Author Designer to make additional modifications.

Customizing the Quick App Color Scheme
Using Quick App settings, you can customize the color scheme of any Quick App. This helps the
runtime user to distinguish display fields from save fields when working with the app.

To customize the color scheme
1. In the ribbon menu, click Quick App and select Settings.
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The Format Options window opens.
2. Provide requisite information in the Format Options window as described in the table.

Field

Description

Worksheet Title
Fill
Color

Click this field to open the color picker and specify the background color for the
worksheet title.

Text
Color

Click this field to open the color picker and specify the text color for the
worksheet title.

Font

Click this field to open the Font window and specify font properties for the
worksheet title.

Header Display Fields
Fill
Color

Click this field to open the color picker and specify the background color for the
Display fields.

Text
Color

Click this field to open the color picker and specify the text color for the the
Display fields.

Font

Click this field to open the Font window and specify font properties for the the
Display fields.

Header Save Fields
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Field

Description

Fill
Color

Click this field to open the color picker and specify the background color for the
Save fields.

Text
Color

Click this field to open the color picker and specify the text color for the Save
fields.

Font

Click this field to open the Font window and specify font properties for the Save
fields.

Example: Quick App for Opportunities by Account
You will use the Quick App wizard to create your first app, and it will take you only a few minutes.
You will build your app in only four steps:
1. Specify which type of app you need.
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2. Select your objects and fields.
3. Select your display and save options and specify a method for getting the data from

Salesforce.
4. Format your workbook.

Using these four steps, you are going to create an app that will:
Retrieve data from the Account and Opportunity objects in Salesforce.
Place that data in a Microsoft Excel worksheet.
Allow you to edit the data in Excel and then save your changes in Salesforce.

Prerequisite
Before you can create an app, you must connect to a Salesforce org that is configured for
X-Author for Excel. For information on configuring and connecting to Salesforce, refer to
Getting Started with X-Author for Excel and Connecting to Salesforce from Excel.

1. Click Quick App and select New.

The Build a Quick App window opens.
2. In the App Name field, type the application name. The name appears as the Excel window

title (located at the top of the Excel window) in the completed app.
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Give your app a name that is concise but also summarizes the basic purpose of the
app.
For this example, you are going to create an Opportunity forecasting app. The app allows
you to search for and select an account record, and then displays all of the account's related
opportunities, so type "Opportunities by Account" in the App Name field.
3. Click the appropriate radio button and select an app type.

Single Object List apps allow you to retrieve data from a single object, such as Accounts. If
you need to retrieve data from more than one object, you will need to create a Parent Child
app. For this example, you need to retrieve data from both the Accounts object and the
Opportunity object, so select Parent Child and click Next. Select the parent object and fields
to use in the app.
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4. The parent object for your app will be the Account object, so click the Parent Object drop-

down menu and select Account. The Account fields are displayed in the field list.
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Notice that the two primary fields are selected by default. Select the Account fields that you will use in
your app. Click the check box next to the following fields:
• Type
• Region
• Owner
• Industry
• Website

You can find fields by scrolling through the list, but it might be easier to use the
Search Fields feature. Just type the field name or field ID in the search box. You
can also sort the fields by Data Type by clicking on the top of the Data Type
column.
5. Click Next.
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6. The child object for your app is the Opportunity object, so click the Child Object drop-down

menu and select Opportunity. The Opportunity fields are displayed in the field list.

7. Select the Opportunity fields to be used in your app. In a child object, the primary lookup

field is also preselected. For this app, you want to allow the user to add new opportunities,
so you must select all the required fields for creating a new opportunity record. (With Quick
App, this only applies to the child, not to the parent. When creating apps using X-Author
Designer, the app can include an ability to create both parent and child records
simultaneously.) For this example, the following additional fields are required, so click the
check box next to each of these fields.
• Amount
• Close date
• Stage
8. Click Next.

Next, decide which fields to display on the Excel workbook, which fields to allow your users
to save back to Salesforce, and which method to use to get the data from Salesforce.
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9. Select the fields that you want displayed to the user in the Excel workbook. Notice that both

the owner ID—which we previously selected—and its lookup name are available. You can
select all the fields by clicking the Display Fields check box in the Select All section (you can
change their display order later), or you can individually select the fields in the order you
want them displayed. The parent object fields will display vertically in Excel. For your app,
select the Display fields shown in the illustration below.

66

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

10. Next, specify which fields your users can update and save back to Salesforce by clicking the

corresponding check box in the Save column. Once again, you can use the Save Fields
check box in the Select All section or individually select the fields. Notice that you cannot
select fields that were not specified as Display fields in the previous step. For your app,
select the following Save fields.

67

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

11. Specify how to retrieve the data from Salesforce by selecting an option from the Data

Criteria drop-down menu. For the parent record, Quick App provides only one option, User
Selection, which allows the user to input search criteria, view the search results, and then
select the record they want to retrieve from Salesforce. This assumes you are opening the
app from Excel. If you open the app by launching it from an account page in Salesforce, then
that account is automatically selected as the parent record.
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This is how the Display fields will appear when you run the app and retrieve data from
Salesforce.

12. Specify the fields that you want your app users to be able to use as search filters when they

click the corresponding check box in the Search Fields column. For this app, select the
following Search fields.

69

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

12.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

13. Specify the fields that you want to be displayed in the search results by clicking the

corresponding check box in the Result Fields column. For this app, select the Result fields
shown in the following illustration.
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Did you know...?
By specifying fields to be used as Search Fields, you just created filters. In the
upcoming steps, you will see how to add other filters based on the fields that
weren't selected as Search Fields.
14. Next, you will add two filters that will allow users to further filter search results. Start by

clicking the Filters button. The Filters window opens.
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Notice that the three fields you specified as Search Fields are already present as User Input
filters. You are going to add two more filters now, one to show only those opportunities in
manufacturing, and another to allow your app users to further filter opportunities by region.
15. Click the Add Row button to add a new filter.
16. In the new row, click the lookup icon

to select a field.

17. Double-click the Region row to add that field to your filters.

.
18. For your app, you only want to see those opportunities that are in the Manufacturing

industry, so click the Value drop-down menu in the Industry row and select Manufacturing.
19. Follow the same process to add another filter. This time, choose the Region field to filter on.
20. Change the Value Type to User Input and, instead of setting a value, change the Operator

from "equals" to "in" so your users can select from the drop-down list and filter data by
region.
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Now your filters should look like this.

By default, filters are all related by the AND Boolean condition, which means that, in
this case, all five of these conditions must be met for a record to be returned as a
search result.
To change the way the filters are related, you can add Boolean logic to the filters by
clicking the Add Filter Logic button. Filter logic in X-Author for Excel works the
same as it does in Salesforce.com. Learn more.
21. Click Save.

This is how your search filters and results fields will look when you run the app.
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22. You are done configuring the parent object, so click Next to move on to the child object,

Opportunity.

This window should look familiar to you. It looks different than the window where we
configured parent-object options (it has fewer columns) because the data criteria is set to
Query.
23. If the Data Criteria field is not set to Query by default, set it to Query now.
24. Select the following Display and Save fields. Note that the fields from the child object will

render horizontally.
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Now you will add two filters to ensure that you see only those opportunities worth a certain
dollar value and in a particular sales stage.
25. Click the Filters button.

Notice that the parent object is already present as an Input filter. You are going to add two
more filters to ensure that you see only those opportunities worth more than $20,000 and
only those that are not set to the stage of Closed Won.
7526.
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26. Click the Add Row button to add a new filter. A new row is added.
27. In the new row, click the Salesforce Object and Field button (

) to select a field.

28. Click the Amount field and then click Select.

29. For the Amount field, click the Operator drop-down menu and select "greater than".
30. In the Value text box, type 20000.
31. Click the Add Row button to add a new filter. A new row is added.
32. In the new row, click the Salesforce Object and Field button (

) to select a field.

33. Click the Stage field and then click Select.
34. For the Stage field, click the Operator drop-down menu and select "not equal to".
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35. Click the Value drop-down menu and select Closed Won.

Your filters should now look like this.

36. Click Save.
37. Click Next. The App Settings window opens.
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All you have to do now is some label work, allow users to add or delete rows in the
worksheet, and decide whether the app should be launchable from within Salesforce, and
you are done.
38. If this is an app that users will access from a button on a Salesforce page, select the Enable

App Launch from Salesforce check box. The app you have just built would be a great
candidate for this because, when the user is on an account in Salesforce and wants to edit
the related Opportunity list, they can just click on a button and do their editing in Excel. (You
will also need to do some setup work inside Salesforce, such as putting the button on the
right page. For more information, refer to Launching an X-Author for Excel App from
Salesforce.)
39. In the Worksheet Title text box, type Opportunities by Account. Remember, this title will

appear in field A1 on your Excel workbook.
40. Change the Group Label to "Opportunities."
41. Click the Enable Add Row check box.
42. Click Finish.

Congratulations! You've completed your first Quick App. Now, you can preview the app to see how
it works.

Adding Salesforce Objects to your App
Before you can add objects to your app, you need to create the app file. Refer to
Designing Apps for instructions to create your app.
Every app you design uses objects and fields from Salesforce. Complete the tasks on this page to
add objects to your app and define which fields from those objects you want to work with.

Object Behavior
All objects used in an app are assigned a behavior that determines their availability in maps and
actions. There are two behaviors:
Individual: Work with an individual record at a time for that object.
List: Work with more than one record for that object.
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Object Combinations
Any number of objects can be selected.
The same object can be selected multiple times in different hierarchies if it needs to be used
in different ways.
A combination of related and unrelated objects can be selected.

To add objects and fields
1. From the X-Author Designer ribbon, click the Salesforce Objects button.

2. From the left pane under Select Objects, choose an object or drill down to other objects by

clicking the + next to the object name.

Type the first letter of the Object you want to add and X-Author will jump to the first
matching object in the list.
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3. To select a top-level (header level) object, click Add Parent Object to move the object to

Selected Objects.

4. If you need to add one or more child objects, drill down from the Parent object one or more

levels, select the child object and click Add Child Objects to add objects in the hierarchy
(from child up to parent) to Selected Objects.
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Changing Object Behavior
By default, when objects are added in a parent-child relationship, parent objects
adopt the "Individual" behavior and the bottom child object in the hierarchy adopts
the "List" behavior.
You can manually change the behavior of any object by right-clicking on the object
name and choosing either option from the drop-down that is displayed (for example,
if you want two objects to have a many-to-many relationship, make both objects
"List").

Caution: Be careful when changing object behavior. If you have already created
other parts of the app, changing object behavior may not make sense in some
circumstances.

81

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform
5. Click Remove Object to remove a selected object from the list.
6. From Select Fields, scroll through the list of fields for the object and select the check box

next to one or more fields to add them to the app. You can also type the name of the field
into the Search Fields dialog to narrow the list of displayed fields.

Note
Click on the heading for any column in the fields table to sort fields by that category.
When a picklist field is selected, all picklist values will automatically be retrieved
during runtime. Regular, dependent, and multi-select picklists are supported.
The following fields are automatically selected for each object and cannot be
deselected.
ID
Name, if there is a Name field
Look-up for a parent object that is selected as part of the object hierarchy
(for example, "AccountId" for Opportunity).
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7. Click Apply after you have finished adding fields for an object. You must click Apply as you

move between objects or your selections will not be saved.
8. When you finished adding objects and fields to your app, click Save and Close.

Best Practices for adding Salesforce Objects
Be careful when removing objects if your app already contains Display Maps or other
components. Removing an object will invalidate any maps and actions in the app. You
must remove those links manually before you remove the object. Generally, if you have
selected the incorrect objects and have already created maps and actions, you should
start over. If it is just unrelated objects that need to be changed, then you can remove that
object after you correct the maps and actions. Then you can add in a new object.

Use Case: Adding Salesforce objects for a Sales Pipeline app
Danny Designer needs to create an app that will be used to manage Opportunity data for
a Sales Pipeline.
He decides that his app is going to need date from the Account, Opportunity and User
objects. Opportunity will be added as a child object of Account, and Account and User will
be added separately as List objects.
Danny takes the following steps to add Salesforce objects to his app:
1. He goes to Apps > New and creates a new app named "Pipeline CC."
2. Danny clicks Salesforce Objects.
3. He finds the Opportunity child object under the Account object and clicks Add

Child Object.
4. Next he clicks Add Parent Object for User and Account.
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5. Danny selects fields for each object. After selecting fields for any object, he clicks

Apply to save his selections.
a. For Account (Individual) and Account (List): Account Description, Account

Phone, Account Type, Annual Revenue, Number of Employees (Account
Name and Account Id are added by default)
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b. For Opportunity (List): Amount, Description, Stage Name, Is Closed, Close

Date, Owner Id (Account (Lookup), Opportunity Id and Opportunity Name are
added by default)

c. For User (List): Active (User Id and Full Name are added by default)
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6. Danny clicks Save and Close to save his objects and fields to the app.
7. Finally, he click the Save App button in the X-Author Designer ribbon to update the

app file in Salesforce.

Working with Display Maps
Use Display Maps to link Salesforce fields to Excel cells for data that will be retrieved from
Salesforce by an app. When data is retrieved from Salesforce by a query or similar action, this
data is temporarily stored in Excel memory before it is placed into the worksheet. X-Author then
uses a Display Map to place the data in the correct Excel cells. You use Display Actions in your
app to implement Display Maps.
How many Display Maps you use is dependent on app design and the timing of data retrieval in
your app. Remember the following when working with Display Maps:
There is no limit to the number of Display Maps in a single app.
A single Display Map can include fields from multiple objects.
A single Display Map can be used across multiple worksheets (not workbooks).

Note
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You do not need a Display Map if your app is not being designed to retrieve data from
Salesforce. If you are retrieving data from Salesforce, then you need at least one Display
Map per app.

Prerequisites
Before you can create a Display Map, you must have defined at least one Salesforce object for
your app. Refer to Adding Salesforce Objects to your App for instructions.

Display Maps and Object Behavior
When you added Salesforce objects to your app, you defined them as Individual (one record) or
List (one or more records). When you map fields in a Display Map, you also choose whether the
field type will be Individual or List. The behavior selected for an object determines how its fields are
used in a Display Map.
Individual object fields can be placed anywhere in the worksheet except in the same row that
contains fields from a List object.
List object fields must all be placed in the same row. This forms a List Range. List object fields do
not need to be placed adjacent to each other, but there must be a start and end cell that represent
the list range. For example, you could have mapped fields in A5, C5, and F5 with formulas in B5,
D5, and E5.
You can find more information on Individual object fields and List object fields in the following
sections.

To create a Display Map for an Individual object
1. From, the X-Author Designer ribbon, click Display Map.
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2. Click Create. The Display Map panel opens in Excel.

3. In the Name field, enter a name for your Display Map. Pick a name that makes it easy to

distinguish from your other Display Maps.
4. Select Individual from the Type picklist.
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Click on the
icon in the upper right-hand corner and choose an option to move or
resize the Display Map panel.
5. Add a field to the Display Map by dragging it from the Display Map panel and dropping it on

the worksheet. The field label is automatically inserted into the cell directly to the left of the
mapped cell. You can search for specific fields using the Search box.
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Best Practice
To make the Display Map more appealing to the end user, highlight a cell
containing a mapped field displayed in brackets and press the Delete key. Never
delete rows to remove these values as it will corrupt the spreadsheet.
6. To remove a mapped field from the worksheet, select the check box next to the field in the

Mapped Details section of the Display Map and click Remove Fields.

Display Map Look Aheads
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You can click the magnify icon
next to any mapped field to create a Look Ahead
. This feature allows the runtime user to double-click on any cell in the retrieved list
of data to lookup specific record values based on how you configure the Look
Ahead. For information on the different types of Look Aheads and how to add them
to your app design, refer to Creating Look Aheads in the Advanced App design
section of this guide.
7. After you have mapped all Individual object fields to your worksheet, click Save.

8. Click Close.
9. Click Save App to save your app.
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To map List object fields to a Display Map
Note: In this task, you will map List fields to the same Display Map created in the previous
task. You can also create a new Display Map for your List fields, but it is often easier,
especially with parent-child apps, to use both Individual and List field types in your
Display Map.

1. From the X-Author Designer ribbon, click Display Map.

2. Click Edit. The Display Map panel opens in Excel.
3. Select List from the Type picklist. All List objects and fields defined in Salesforce objects are

displayed in the panel.
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4. Select the Vertical check box so that the list of displayed records will be shown from top to

bottom. Horizontal layouts are covered in a later section.
5. Add fields to the Display Map by dragging them from the Display Map panel and dropping

them onto the worksheet in the same row. You can search for specific fields using the
Search box. Fields are not required to be adjacent to each other, but there must be a start
cell and end cell, which forms a List Range. You can also add fields from related objects
(such as Account, if you are creating a list of Opportunities).
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Working with List Ranges
The following rules and guidelines apply when you are mapping List Ranges:
Must include
the record id
if you are
planning to
save data

If you are planning to save back to Salesforce any data
that has been retrieved into a List Range, you must
include the record ID somewhere in the range. The best
place to put this field is at the end of the range but it can
be placed anywhere.
The record ID is used to make sure that the Excel rows
and Salesforce records remain connected should the end
user sort data in the range.

Formulas in a
List Range

Formulas can be added into either mapped or nonmapped cells in a List Range.
Formulas are inserted into the List Range cells as each
record is retrieved into the worksheet via the Display
Map.
Formulas in cells where Salesforce data is being
retrieved and displayed will be overwritten by the
Salesforce data but are still very useful if you allow users
to add rows. This is covered in Adding Rows to
Worksheets.

List Rows are
Inserted

As each List Salesforce record is retrieved and displayed,
an Excel row is inserted in the workbook.
Anything you have placed below or alongside a List
Range (for example: a total formula below the range or a
pivot table), is pushed down accordingly.

Fields from
related
objects
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List Ranges
for different
objects

These can be created below other ranges or on other
worksheets.

Grouping and
sorting

Map fields that you want to group by at the left of the list
range. See Grouping and Sorting List Ranges for more
information.

6. Click Close.
7. Click Save App to save your app.

Rich Text Fields in List Ranges
You can insert Rich Text fields in the same way you enter any other field. Rich text fields
appear to runtime users as a single link. The link opens an editor that allows the runtime
user to modify the Rich Text field. Rich Text fields can only be edited by the runtime user
if it is part of a list range (List object field). Rich Text fields of the SaveOnly type cannot be
edited.

Use Case: Sales Pipeline Display Map Part 1
Danny Designer is designing an app with Account, Opportunity and User objects for sales
persons to use to manage their sales pipeline. He has already selected the Salesforce
objects for the app and now needs to create a Display Map to link data from Salesforce to
the cells in the Excel workbook.
Danny takes the following steps to create a Display Map:
1. Danny connects to Salesforce and opens the Sales Pipeline app.
2. He clicks Display Map and clicks Create to start a new Display Map.
3. Danny enters the name "Pipeline Main" for his Display Map and selects List from

the Type drop-down.
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4. Next, he drags and drops fields from the Account.Opportunity child object list to

map them to the Display Map.

5. Danny chooses to Hide column H. He added the field so that the user can save

data back to Salesforce but he does not want to display it in the worksheet.
6. Next, Danny adds a formula in D6 to SUM the Opportunity Amounts in D4.
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7. Danny clicks Save on the Display Map Panel and clicks Close.
8. Danny clicks Save App to save all changes to the app.

Grouping and Sorting List Ranges
After mapping List fields to a Display Map, you can define List Range sorting and group from the
Display Map Options tab. In many cases, native Excel sorting and grouping options are more
flexible.

To sort and group List Ranges
1. From the Display Map panel, click on the Type picklist and select "List."
2. Click the Options tab.
3. (Optional) Type a description in the Header field to display above the label row of the list

range.
4. For Sort by field 1 and Sort by field 2, select an individual column to sort by. Choose

whether records will be sorted in Ascending or Descending order.
5. For Group by field 1 and Group by field 2, select a column in the repeating range to group

by.

Best Practice
Fields you intend to Group by should be mapped at the leftmost side of the List
Range when you create a Display Map.
6. Click Save.
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Grouping and Sorting support for numbers, decimals and
currency
Support is included for both single and two levels of grouping in Display Maps:
You can total all numbers, decimals and currency fields
You can create totals on all Formula fields. Totals are displayed for formula fields
having datatype as number, decimal and currency.

98

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

Use Case: Sales Pipeline Display Map Part 2
1. Danny decides that the Display Map he created (see Working with Display Maps)

needs some grouping and sorting options. He clicks on Display Map, selects the
"Pipeline Main" map and clicks Edit.
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2. From the Display Map panel, Danny clicks on the Type picklist and selects "List."
3. He clicks on the Options tab in the Display Map panel and selects the following

options:
Objects: Account.Opportunity
Layout: Vertical
Sort by field 1: Account.Opportunity.Name
Group by field 1: Account.Opportunity.Owner (Name)
Group by field 2: Account.Opportunity.Account (Name)

4. To improve the appearance of the app, Danny removes the bracketed text from

each cell in row 4, removes the gridlines and adds some color to the app.

5. He clicks Save on the Display Map and Close.
6. Danny clicks Save App to save all changes to the app.
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Vertical and Horizontal Layouts
Records in a List object can be displayed either vertically or horizontally. In vertical layouts,
records are presented as rows with each column being a field. For horizontal layouts, each record
is a column and the rows are represented by the fields. The steps are the same as you would use
to create a Display Map, but select the Horizontal radio button instead of the Vertical radio button.

Horizontal Layout Restrictions
Records can be retrieved and updated but you cannot add or delete records.

Moving and Removing Mapped Fields
After a cell has been mapped to a field in Excel, it is critical that X-Author be able to find that
location in runtime. X-Author can easily adjust its map links when fields need to be relocated,
provided these changes are performed correctly. Follow the tasks in this section to properly move
or remove fields from Display Maps and Save Maps to preserve cell mapping.

Do not use Excel's Delete Row or Delete Column functions to manually delete a row, field
or column in the worksheet. Cells will no longer be correctly mapped and you app will be
corrupted.

To remove a field from a Display Map
1. From the X-Author Designer ribbon, click Display Map.
2. Select the Display Map you want to change and click Edit.
3. Under Mapped Details, select the field to be removed. If you want to remove all the fields in

the map, select the check box next to the left of the Name column.
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4. Click Remove Fields.

5. Click Save.
6. Click Close.

When you remove a field from a Display Map that is already part of a Save Map, the field
will be removed from the Save Map as well.
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To move a field from one cell to another
1. Close all open Display Maps and Save Maps.
2. Place your cursor in the cell to be moved. Right-click on the cell and select Cut.
3. Place your cursor in the target cell. Make sure there is not already a mapped field in that cell.

Right-click on the cell and select Paste.
4. The label (which may be above or alongside the field) will also need to be moved or just re-

entered. Moving the label does not move the data field itself. You can simply drag the label
to the new location; it has no impact on the Display Map.
5. Click Save App. This last step relocates the field mapping.
6. Open the Display Map or Save Map that contains the mapped field or fields. The Mapped

Details pane shows the new mapped cell locations.

To move a column
1. Close all open Display Maps and Save Maps.
2. Highlight the column. Right-click and select Cut.
3. Highlight the target column. Right-click and select Paste.
4. Click Save App.
5. Open the Display Map or Save Map and check the Mapped Details to confirm cells were

properly remapped.

To insert or delete rows or columns
1. Close all open Display maps.
2. Place your cursor on the row or column heading where you want to perform an insert/delete.
3. Right-click on the row or column and select Insert or Delete..
4. Click Save App.
5. Open the Display Map or Save Map to confirm cells were properly remapped.
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To delete an existing Display Map
You cannot delete a Display Map that is being used by a Display Action.

1. From the ribbon, click the Display Map button.
2. From the list of Display Maps, select a Display Map and click Delete.

Working with Save Maps
Use Save Maps to link Salesforce fields to Excel cells for data that will be saved to Salesforce.
Save Maps often rely on Display Maps (see Working with Display Maps). You use Save Actions in
your app to implement Save Maps.
Saving Data to Salesforce
Updates
Inserts
Deletes
Working with Save Maps
To create a Save Map for Display Map Fields
To create a Display Map for Other Fields
To delete an existing Save Map
Creating Preloaded Grids
To create a Preloaded Grid

Saving Data to Salesforce
X-Author for Excel supports updates, inserts, upserts, and deletes.

Updates
Save Maps can be designed to update records in Salesforce in three ways:
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Records were retrieved from Salesforce and the data from one or more fields in that record
were placed on the worksheet through a Display Map. Using the Add Display Map Fields
function in a Save Map, user modifications to any cell can be updated on the record.
Using the Add Other Fields function to save data from one or more fields that were not
retrieved from Salesforce. It is not recommended to update fields to Salesforce using this
function, but if you do update in this way, you must always include a Record ID in the same
row as the fields you are updating.
Using the Add Matrix Map Section function in a Save Map, modifications to matrix map
sections can be updated on the record.

Inserts
New records can be created in three ways:
When a user adds a new data row using the Add Row menu button.
When the App automatically adds a new data row using the Add row Action and pastes
data into the new row.
Using a Preloaded Grid (see Creating Preloaded Grids).

Deletes
Rows can be deleted from Display Map lists by the user clicking the Delete Rows from Salesforce
menu button. To delete one or more records from a List, the Display Delete Row from Salesforce
must be checked in User Menus and there must be a Save Map with at least one field in it.

Working with Save Maps
How many Save Maps you use is dependent on app design and how many save options you have
for the user at runtime. Remember the following when working with Save Maps:
There is no limit to the number of Save Maps you can have in an app. Multiple Save Maps
allows you to control which fields are updated when the user clicks a menu button
associated with a specific save process.
A Save Map can include fields from any number of objects.
A Save Map can be used across multiple worksheets (not workbooks).
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To create a Save Map for Display Map Fields
1. From the X-Author ribbon, click Save Map.

2. Click Create. The Save Map panel opens in Excel.
3. In the Name field, enter a name for your Save Map. Pick a name that makes it easy to

distinguish from your other Save Maps.
4. Click Add Display Map Fields.
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Click on the
arrow icon in the upper right-hand corner and choose an option to
move or resize the Save Map panel.
5. Use the Filter by drop-down to filter the list of fields for a specific Display Map.

6. Select the fields to add to your Save Map, and click Apply. Click Select All if you want to

choose all Display Map fields.

7. Click Save.
8. Click Close.
9. Click Save App.
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Use Case: Sales Pipeline Save Map
Danny Designer is designing an app with Account, Opportunity and User objects for sales
persons to use to manage their sales pipeline. He has created a Display Map to link data
from Salesforce to the cells in the Excel workbook and now needs to create a Save Map
for saving data back to Salesforce.
Danny takes the following steps to create a Save Map:
1. Danny connects to Salesforce and opens the Sales Pipeline app.
2. He clicks Save Map and clicks Create to start a new Display Map.
3. Danny enters the name "Save Pipeline" and clicks Add Display Map Fields.
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4. Danny decides that all of the Opportunity fields should be enable for saving back to

Salesforce. He clicks Select All and clicks Apply.

5. Danny clicks Save to save the map and clicks Close.
6. Danny clicks Save App to save all changes to the app.

To create a Display Map for Other Fields
1. From the X-Author ribbon, click Save Map.
2. Click Create (or select an existing Save Map and click Edit).
3. In the Name field, enter a name for your Save Map. Pick a name that makes it easy to

distinguish from your other Save Maps.
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4. Click Add Other Fields.

5. Select Individual or List from the Type drop-down.
6. Select the Vertical layout.
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7. Use the Search dialog or navigate the object hierarchy to locate fields. Add fields to the Save

Map by dragging them from the panel and dropping them onto the Excel worksheet. You can
search for specific fields using the Search box.

8. After adding one or more fields, click Add to Save Map. The Save Map now displays the

added fields in the Save Map panel and "Save Only" as the Field Type.
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9. Click Save and Close.
10. Click Save App.

For information on adding Matrix Map sections to Save Maps, refer to Creating a Matrix
under Advanced App Design.

To delete an existing Save Map
You cannot delete Save Maps that are used in a Save action.

1. Click Save Map.
2. From the list of existing Save Maps, select one and click Delete.
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Creating Preloaded Grids
When your save requirements require something more complex than a list, you can use a
Preloaded Grid with your Save Map. A Preloaded Grid can only be used to add new records. For
example, you might have a six-row-by-three-column grid with three rows of formulas and an empty
row between each. The formulas recalculate based on values elsewhere in the workbook. You
want each of the three rows to be inserted as Salesforce records each time the input values
change and the user clicks Save.

To create a Preloaded Grid
1. In a Save Map, click on Show Preloaded Grid.
2. In the Preloaded Grid window, select the List Object for which you are creating the grid.
3. Enter the number of rows for the Preloaded Grid.
4. Click the check mark when finished. The object will now have an identifier in brackets for the

number of rows added. To change the number of rows, enter in a new number in Preloaded
Rows.
5. Click Save.

Customizing the App Experience
Actions are used to create a specific user experience. They include being able to query, display,
save, and manipulate data within the workbook. The top section of the Actions menu button
provides access to existing Actions. Click the down arrow at the bottom of the button to create new
Actions.
Click on the Action Name in the following table for more information on the action.
Action
Name

Action Type

Add Row
Action

Adds a row to the top or bottom of your Display Map.

Check-In

Saves the Excel file to Notes and Attachments in Salesforce and unlocks the file.

113

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

Action
Name

Action Type

Check-Out

Opens a previously saved X-Author for Excel file from Salesforce Notes and
Attachments and then locks the file to prevent editing by any other user.

Clear

Clears cell data.

Dataset
Action

Combines outputs of Query Actions to overcome SOQL limitations.

Display

Places retrieved data in the worksheet based on a Display Map.

Macro

Runs an existing macro.

Paste
Action

Counts the rows from which data has been copied and then pastes the copied data
into those rows.

Query

Queries data from Salesforce.

Salesforce
Method

Calls a Salesforce Method.

Save

Saves worksheet data to Salesforce based on a Save Map.

Saves the entire Excel file or specific worksheets in the Excel file to Notes and
Save
Attachment Attachments as an xls or pdf.
Search
and Select

Allows a user to search for and select data that will then be retrieved into the
workbook or that will provide a filter to a subsequent search or query. Retrieves
data from Salesforce based on the user record selection.

Switches between orgs to allow uploading and downloading data across multiple
Switch
Connection orgs.
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Display Action
When data is retrieved from Salesforce using a Query or Search & Select action, it remains in
memory until a Display Action places that data into the workbook based on a Display Map.

Note
To create a Display Action, you must have an existing Display Map.

To create a Display Action
1. Click the lower section of the Actions button and select Display.

2. In the Action Name field, enter a name for your Display Action. Use a name that describes

the records to display.

115

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform
3. Click the drop-down next to Display Map to select the Display Map to use.
4. Click Save.

To show query filters in the worksheet
Perform the following optional steps when creating a Display Map if you want to display the filters
used in any Query or Search & Select actions used to display records for the specified Display
Map.
1. Select the Show Query Filters check box.
2. Select one or more Display Map Objects for which you want to display the query filters for

during runtime.
3. For each Display Map object selected, enter a worksheet cell location in the Filter Location

in Excel field. At runtime, all configured filters for queries used in that Display Map are
populated in the specified cell location. For example, specifying the filter location Sheet2!B2
displays query filters for the corresponding Display Map object in the cell B2 on Sheet 2.
You can also specify a named range as a filter location.

4. Click Save.

Runtime Behavior: When the App is executed during runtime, the query filter is displayed in
Sheet 2 in cell B2. The query filters can also be displayed in merged cells.
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Query Action
The Query action is a point-and-click query builder. The Query action retrieves data from
Salesforce based on predefined parameters and, if specified, user input during App runtime. You
can create as many queries as needed and use them more than once across Action Flows.
You can add many filters to Query Actions that are either hard-coded or that rely on either user or
spreadsheet input at runtime. These filters can also be connected using filter logic. Query actions
work with Display Actions to retrieve and display records in apps.

To create a Query action
1. Click on the arrow beneath the Actions button and select Query.

2. Enter an Action Name. Use a descriptive name, for example, Query Opportunities.
3. From the Object drop-down list, select an Object.
4. Type a number in Max Records to specify the maximum number of records to be returned.

Leaving it blank will return all records unless otherwise restricted by the filters below.
1175.
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5. Click the Enable Favorite Filters check box to enable Favorite Filters for this query action.

Refer to Enabling and Using Favorite Filters in Queries for more information.
6. In the default filter row, click the lookup icon

and select a field from the selected object
or click on an orange lookup field to navigate to a related object and select a field from there.
To select a field from a lookup object, the object and field must have been selected in
Salesforce Objects.

7. Select one of the following Value Types:

Input: This is for restricting records from the selected object based on a field from
another object. It also implies that an input is required during an Action Flow. For
example, retrieve all opportunities for an account that was previously selected by a
user in a search and select action. X-Author Designer will automatically suggest
matching fields from the related object. Select the correct field from the drop-down
list.
Static: Type a specific value to restrict which records are retrieved. For example, only
get records where the Geo field equals "West". If you set the Value Type as Static,
and the operator as in or not in and the query has more than 20,000 characters, the
query is executed successfully during run-time. If the query condition comprises more
than 20,000 characters, the query is chunked into multiple queries executed
separately and the results are combined into a single query execution.
System Variables: There are three system variables available for use.
Current User - Used to restrict records based on the currently logged in user.
Current Date - Used to restrict records to the current date.
ExportRecordId - Used for Apps that are launched from Salesforce.
User Input: This will generate a user input field at runtime. This option will present the
field name to the user at runtime unless you change it as follows:
Hover over the field name and a pop up will be displayed. Change the field name in
the pop up and click the green check mark. To remove a label, click the red cross
mark.
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If you set the Value Type as User Input, the operator as in or not in and the user input
query has more than 20,000 characters, the query is executed successfully during runtime. If the query condition comprises more than 20,000 characters, the query is
chunked into multiple queries executed separately and the results are assimilated as
a single query execution.
Cell Reference: This will filter the query results based on the value of a cell reference
provided. If you set the Value Type as Cell Reference, and the operator as in or not in
and the query has more than 20,000 characters, the query is executed successfully
during run-time. If the query condition comprises more than 20,000 characters, the
query is chunked into multiple queries executed separately and the results are
combined into a single query execution.

The Cell Reference Value Type is not supported in Presto Apps.
8. Select an Operator. The following table describes combinations of field types, value types,

and operators (click to enlarge).
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Formula field types are also supported. The corresponding supported operator
types depend on the the datatype the formula field returns. The supported return
types for formula fields are boolean, double, string, currency, percent, date and
email.
9. Click Add Row to create more filter conditions.
10. Click Save.

Filter Logic
X-Author uses the same filter logic method as Salesforce.
Example: For the defined filters, find records that match both the first two filters or the third. Enter
filter logic as (1 AND 2) OR 3, or 3 OR (1 AND 2).
Find records where the amount is greater than “$10 million” AND the close date is earlier than “03
/19/2016” OR any opportunity where stage equals “Qualification".
Amount > 10000000, Close Data < 03/19/2016, Stage = 'Qualification'
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See also: https://help.salesforce.com/htviewhelpdoc?
id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US.

Using Filter Logic at Runtime
When a query defined as User Input includes a picklist field as one of the criteria, you can see a
preview of the values in the list.

To specify a value for the query, click the ellipsis button next to a field to see additional picklist
values.
When you click the ellipsis button a pop-up appears.
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Add one or many values to the Selected Values area using the right arrow.
Quick Search is a wildcard search which automatically filters down the list of available
values in the list below.
The values moved to the right under Selected Values area are selected for In or Not in"
operator processing.
After the user selects a list of values and clicks on Save, the window closes and the text on
the Runtime screen shows the values separated by a comma in the textbox.

Search and Select Action
The Search & Select action provides an interactive way for the end user to search for and select
one or more records to retrieve from Salesforce. Along with the Query Action, Search & Select is
the primary means for retrieving records from Salesforce. Search & Select actions work with
Display Actions to retrieve and display records in apps. A Search & Select action executes two
calls to Salesforce when invoked:
the first call assists the user in searching and selecting the data they need
the second call retrieves all fields for the records selected by the user
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To create a Search and Select action
1. Click on the arrow beneath the Actions button and select Search and Select.

2. On the Options tab, under Search and Select Action, type an Action Name. Use a

descriptive name, for example, Search Opportunities.
3. In Object, select an object.
4. Click the Enable Favorite Filters check box to enable Favorite Filters for this action. Refer

to Enabling and Using Favorite Filters in Queries for more information.
5. In Searchable Fields, select one or more fields that will be displayed to the end user as input

fields at runtime.
6. In the Result Selection, decide whether the user can select a single or multiple results that

are returned to Excel, and select a Result selection. (You can only select Single for an
Individual object, or Multiple for a List object.)
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7. In the Fields to Display in Search Results, select one more fields to display in the search

results. Select a check box in the Sort By column to choose the primary sort. Note: At
runtime, the user can also sort by any column when the results are displayed. You can also
reorder the result columns using the Arrows to the right of the grid.

8. Add filters as required. Refer to the Query Action for details on how to create filters.
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9. Click Save.

Save Action
A Save Action pushes Excel workbook data into Salesforce based on a Save Map.

To create a Save Action, you must have an existing Save Map.

To create a Save Action
1. Click the lower section of the Actions button and select Save.
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2. In Action Name, type a name. Pick a descriptive name to identify each Save action you

create.

3. From Save Map, select an existing save map.

Note
Consider the following optional settings:
Select the Enable Collision Detection check box to enforce collision
detection during a Save Action. If another user has modified a field in a
record subsequent to when that record was retrieved by the current Excel
user and the current Excel user is trying to update that same field, then XAuthor will prevent that record from being saved.
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Select the Enable Partial Save check box to allow valid rows to be saved to
Salesforce even if other rows have errors or other issues (for example, rows
that cannot be saved due to collision detection). Deselecting this box will
prevent all rows from being saved even if there is a single error.
Select the Highlight Unsaved Records check box to highlight the cells or
rows that have an error during a Save Action.

4. Click Save.

Clear Action
A Clear action clears the cells in the workbook for a specified Save Map. It is used when, for
example, you are adding a record to an Individual object using a form and you need to clear the
cells after each record has been added so you can add the next one. Another example would be
when you want to combine process creation and editing in the same app, like quoting.

To create a Clear action
1. Click on the arrow beneath the Actions button and select Clear from the drop-down. The

Clear Fields Action window opens.

2. In the Action Name field, type a descriptive name for the action.
3. From the Display / Save Map drop-down, select an existing map.
4. Click the check box next to the object to be cleared and it will be displayed in Selected

Objects.
5. Click Save. You can select additional Save Maps and objects as necessary.
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Delete Action
Before you create and use a delete action, you must update the License Webservice Endpoint
custom setting to enable the delete action.

To update the License Webservice Endpoint custom setting
1. Go to Setup > App Setup > Develop > Custom Settings.
2. Click Manage for X-Author for Excel System Properties and click New.
3. In Name, type System Properties as the data set name.
4. In License Webservice Endpoint, enter https://ls.apttus.net:8443/cgi-bin/1.3/LicenseServer

/Bin/LSCGI.exe
5. Click Save and follow the instructions to refresh your license.
128

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

The Delete Action is enabled. Using the Delete Action, you can delete records for an object based
on specific filter criteria. You can delete records for only those objects referenced in the Save Map
having Display Map fields along with Save other fields. If you do not specify any filter criteria, all
the records for the object are deleted. You can specify a maximum of 20 filters. The Delete action
is supported only on Enterprise and Power Admin Editions.

To create a Delete Row action
1. In the ribbon menu, click the Actions drop-down menu and select Delete. The Delete Action

window opens.

2. Complete the fields described in the following table.
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Name

Type a name for the new action.

Save Map

Select an existing Save Map to use when deleting rows.
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Field

Description

Object

Select the object that you want to delete the records for.

3. Specify the filters based on which you want to delete the records. For example, you can

choose to delete records if the Approval Status of the record is Rejected. Operators are
supported based on the datatype of the field, such as equals, not equal to, greater than,
greater than equal to, less than, and less than equal to. IN and Not In operators are not
supported in this release. Only Static value type is supported in the May 2016 release and
later.You can specify a maximum of 20 filters.
Filters are displayed based on the following conditions:
Save map containing only display map fields will show all filter fields.
Save map containing display and save other fields both will show all fields.
Save map containing only save other fields shouldn't show anything.
Empty columns that are a part of the display map also appear in the filter fields.
4. To ensure that the user knows that a delete action is executed at runtime, the Prompt

Configuration Message Before Deleting records check box is selected by default. If the user
clicks Yes, the records are deleted and the next action in the action flow is executed. If the
user clicks No, the next action in the action flow is executed.
5. Click Save.

Add Row Action
The Add Row Action lets you automatically add rows to the top or bottom of your spreadsheet as
part of your flow. You can add a row containing data from a specified set of cells or from another
action flow step, or you can add a specified number of empty rows and allow users to insert the
data.
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To create an Add Row action
1. In the ribbon menu, click the Actions drop-down menu and select Add Row. The Add Row

Action window opens.

2. Complete the fields described in the following table.

Field

Description

Name

Type a descriptive name for action (for example, Add Row – Opportunities).

Save
Map

Select an existing Save Map to use when adding rows.

Select the list object for which you will add rows.
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Field

Description

List
Object
Location

Specify whether to add the new rows before or after the existing data.

Input
Type

Select the method used to determine how many rows will be added.
Action Flow Step Input – The number of rows added will be determined
by the outcome of a previous step in the action flow. For example, if you
have a Search and Select action in the flow, the number of rows added
will equal the number of rows selected during that step.
Cell Reference – Select this option to specify a cell in the workbook,
such as Sheet3!A1, that contains the numerical value of the number of
cells you want to add.
Number of Rows – Select this option to specify a static number of rows
to add.
User Input – Select this option to allow the runtime user to specify the
number of rows to add.

3. Click Save.
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Check-In Action
The Check-In action saves the Excel workbook to the Notes and Attachments of a designated
record and then unlocks the workbook and enables it to be checked out by another user.

Prerequisite
Because the workbook must be attached to a single record, your app must identify at
least one Individual object in Salesforce Objects.

To create a Check-In action
1. Click on the arrow beneath the Actions button and select Check-In.

2. In the Action Name field, type a descriptive name for the action.
3. From Object, select an object and click Save. The list of objects will only include Individual

Salesforce Objects.
4. In the File Name, select the option to type the file name that will be used when the file is

checked-in.
Field Name

Description

Use Runtime
Filename

Select this option to allow your user to enter the File Name at run time.

Select this option to allow your user to enter the File Name manually.
Enter the file name manually.
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Field Name

Description

Manually
Provide File
Name
Use Cell
Reference as
File Name

Select this option to allow your user to use a cell reference as the File
Name. Select the cell and click the icon. Note: This feature is not
available with Presto apps.

Check-Out Action
The Check-Out action provides the runtime user with a list of all files previously checked into the
designated object or record and they can select one of those files to open. This then locks the file
for other users until it is checked back in by the current user.

Because the workbook is checked out from a single record, you must have at least one
object identified as Individual in Salesforce Objects. You must also have at least one
Check-In action.

134 create a Check-Out action
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To create a Check-Out action
1. Click on the arrow beneath the Actions button and select Check-Out.

2. In the Action Name field, type a descriptive name for the action.
3. From Object, select an object and click Save. The list of objects will include any object

marked as Individual in Salesforce Objects.

Paste Action
The Paste action adds rows and pastes data from the clipboard into those rows.

To create a Paste action
1. Click on the arrow beneath the Actions button and select Paste.
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2. In the Name field, enter a descriptive name for Paste action.
3. From Save Map picklist, select the Save Map for your Paste action.
4. From the List Object picklist, select the appropriate object (of List type).
5. Do any one of the following:
a. To add the rows at the top of the current data selection, select Top from Add row

location.
b. To add the rows at bottom, select Bottom from Add row location.
6. Do any one of the following
a. If you want to paste all the rows and data, select Paste All.
b. If you want to paste the values only, select Paste Values Only.
7. Click Save.
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Paste Data Source Action
The Paste Data Source action is the automated equivalent of the runtime Paste with Mapping
feature and is primarily used for migrating data between Salesforce orgs. The manual process
maps data between source and target orgs using the Source Data function and then uses Paste
from Mapping to copy the data downloaded from the Source org into the Target workbook using
the Source Data layout.This action automates that process so that the migration can run
uninterrupted.

Prerequisite
The Paste Data Source action requires a licensed edition that includes data migration.
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To create a Paste Data Source action
1. Click on the arrow beneath the Actions button and select Paste Data Source. The Paste

Source Data window opens.

2. In the Name field, type a descriptive name for the action.
3. To automatically paste the data from the source file when called from the Action Flow, select

the Input Source File at Runtime check box.
4. Click Save.
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Switch Connection Action
Using the Switch Connection action, you can make your apps automatically disconnect from one
org and connect to another while executing an action flow. This is very useful if, you are migrating
data between orgs, or need to download and compare data across orgs without requiring a user to
manually switch.
When you design your app and add the Switch Connection action to your action flow, your runtime
users are prompted at the beginning of the action flow to add the connection information.

To create a Switch Connection action
1. Click on the arrow beneath the Actions button and select Switch Connections.

The Switch Connections Action window opens.
2. Type a name in the Action Name field.

This name displays on the X-Author Designer. For example, this is the name you will see
when you design your action flows.
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3. Type a name in the Switch Connection Name.

This name displays to the runtime user and should be used to prompt the user to enter the
correct connection information.
4. Click Save.

You can now add the Switch Connection action to your Action Flows.

Using the Switch Connection Action at Runtime
If an app uses the Switch Connection action, the runtime user will be prompted for connection
information when the app starts. If multiple connection changes are required, the runtime user will
be prompted for all connection information at one time.
Enter the connection information in the correct order and click Connect for each connection. When
all connections are completed, click Close.

Macro Action
The Macro action executes a macro from the workbook. It can be executed at any time during an
Action Flow and it can also be used to conditionally stop the next step in an Action Flow from
executing.

To create a macro action, you must have an existing Macro in the Excel workbook.
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To create a Macro action
1. Click on the arrow beneath the Actions button and select Macro.

2. In Action Name, type a value that describes which Macro will be executed.
3. From Macro Name, select an existing macro.
4. Select the Terminate Action Flow conditionally check box if you want to terminate the

action flow conditionally. The table below describes the behavior of the check box.
Macro

Terminate Action Flow conditionally check
box

Result

True

Selected

The action flow will be
terminated.

False

Selected

The action flow will continue.

5. Select the Disable excel events before macro execution checkbox.

Depending upon the value of the checkbox, enable or disable the excel events in macro
action.
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The following use case shows an example of this.

Use Case: Creating a Macro Action
Diana Designer wants her end-users to fill out certain information within an App before
sending an update to Salesforce. To enforce this, she creates a macro which looks at
certain criteria, such as making sure there are values in a few record’s. Example: Amount
and Close Date fields. This macro generates a True or False output depending on if the
logic in the macro is met. Next, she creates a Macro action and associates the macro to
it. She sequences the Macro action before the Save action in an action flow. Diana
created the Macro action to conditionally stop the Save action from executing. Now, when
the end user performs tasks and if the criteria is not met at the time the Macro action
executes, the macro action reads the TRUE output from the macro and then terminates
the action flow. The Save action is not enabled.

Salesforce Method Action
The Salesforce Method action enables you to call Salesforce Apex classes.

To create a Salesforce Method action
1. Click on the button beneath the Actions button and select Salesforce Method.
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2. Under Action Details, type an Action Name for the call procedure action.
3. Under Salesforce Method Details, select a Class and type the name of the Method.
4. If the procedure has a return value, select Has return value and select a Return Type

object.
5. If the procedure has parameters, select Has parameters. The Specify Params section is

enabled.
6. Type a Param name, and select from the following:

Static: Type a value.
Object: Enables the Object list. Select an object.
Field: Enables the Field list. Select an object field.
User Input: This displays an input field to the user at runtime and passes that input to
the Salesforce Method.
7. Click Add Param to add more than one parameter.
8. Click Save.
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Save Attachment Action
The Save Attachment action saves the entire workbook or specific worksheets to the Notes and
Attachments section of an Individual object. A new attachment is inserted each time this action is
executed. This action does not provide any file locking. Use a Check-Out action if file locking is
required.
An attachment can be saved either as an Excel or PDF file format.
When an attachment is downloaded, the file name is the actual filename in Salesforce. <filename
in Salesforce>.<extension in Salesforce>.
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If a file with the same name and extension exists, a sequence number is appended after the
filename, such as <filename in Salesforce> (2).<extension in Salesforce> and <filename in
Salesforce> (3).<extension in Salesforce>.

To create a Save Attachment action, at least one object must be identified as Individual in
Salesforce objects.

To create a Save Attachment action
1. Click on the arrow beneath the Actions button and select Save Attachment.

2. In Action Name, type a descriptive name for the action.
3. In File Name, type a file name to be used when the file is executed.
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Description

Use Runtime
File Name

Select this option to use the existing File Name at runtime.

Manually
Provide File
Name

Select this option to allow your user to provide the File Name manually.
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Field Name

Description

Use Cell
Reference as
File Name

Select this option to allow your user to use a cell reference as the File
Name. Select the cell and click the icon. Note: This feature is not
available with Presto apps.

4. From Object, select an Individual object.
5. In Format, select whether to save the attachment as Excel or PDF.
6. Leave Custom Sheet Selection blank to save the entire file as an attachment or select the

check box to save specific worksheets. Hold the Ctrl key to select multiple worksheets listed
in Include Sheets.
7. Click Save.

Dataset Action
Salesforce has various query limitations:
1461.
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1. SOQL statements cannot have more than one level of sub-query.
2. Sub-queries cannot be executed when there is an 'OR' clause in the filter.
3. SOQL statements cannot exceed 20,000 characters in length.

If your query exceeds 20K characters, an SOQL error appears stating the query cannot exceed
20,000 characters in length. X-Author helps overcome these limitations using a combination of
automated functionality and the Data Set Action (simulates a SQL union function).
X-Author checks the queries in runtime and automatically runs sub-queries and data chunking
functionality to overcome a >20K character query. If during testing you find that even this is
insufficient, then create a Data Set Action where you can break the query action into multiple query
actions and use the query output as an input to the Data Set action.
Using the Data Set Action, you can merge the output of two queries into a single Data Set based
on the OR clause or AND clause. When you specify 'OR' clause for query outputs, one output Data
Set is created by union of the two query outputs. When you specify the AND clause for query
outputs, one output Data Set is created by intersection of two query outputs.

Prerequisites
1. Make sure that the application type is Power Admin. The Data Set Action can be only

executed in applications that have the Power Admin edition.
2. For all queries that cross the limit of 20K, split the query into separate query actions. Ensure

that your split query meets the following criteria:
1.

If there are two 'IN' filters or 'NOT IN' filters and if the query crosses the limit of 20K,
ensure that you:
Separate the 'IN' clause from the query and create a different query action.
Create two separate Query Actions each having a single 'IN' filter.
While creating an action flow and selecting a query action, ensure that ‘Persist
Data in Output’ checkbox is selected.
Using the Data Set action procedure below, merge the data retrieved by both
the query action in a single Data Set using a Data Set Action. You can choose
to use the 'OR' clause or 'AND' clause to merge the data into a Data Set.
If there are two or more 'IN' filters or 'NOT IN' filters and if the query crosses the limit
of 20K, ensure that you:
Separate the 'IN' clauses into a separate query action.
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While creating an action flow and selecting a query action, ensure that ‘Persist
Data in Output’ checkbox is selected.
Using the Data Set action procedure below, merge the output of those query
action flows using a Data Set Action into a single data set.

To create a Data Set action
1. Click on the arrow beneath the Actions button and select Data Set.
2. Enter an Action Name. Use a descriptive name. For example, Data Set Product Name.
3. From the Object drop-down list, select an Object. The object of the Data Set must be the

same as those of the split Query Actions.

4. Specify the operator for the Data Set as AND or OR. The output of the different queries is

merged into the Data Set, either as a union or an intersection.
5. Navigate to Action Flows, do any of the following:
a. To create a new Action flow, click Create, specify a name for the action flow. Click

Add a step.
b. To add a Data Set to an existing Action Flow, select the existing Action Flow and click

Edit. Click Add a Step.
6. Enter the Step Name.

Before you create a Data Set action step for an Action flow, make sure that steps
for the Query Actions exist.

1487.

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform
7. Select the Data Set Action. The Data Set Action that you specify must have subsequent

Query Action flows created for it based on the object you select.
8. Specify the name of the Data Set Action Output.
9. Make sure to select the Provide Input and Persist Data in Output check boxes.
10. In the Action Input Area, specify the query actions from which the output is merged.

11. Click Apply.
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Executing Actions
An Action Flow is a sequential set of Actions that is executed when an end user clicks a Designer
configured user menu button in runtime. Each Action in an Action Flow can, and in some cases
must, take inputs from prior actions and provide outputs to subsequent actions.

To create an Action Flow
1. Click the Action Flow button on the X-Author Designer ribbon.
2. Click Create.

3. Enter an Action Flow Name and then click Apply.

Note
Each Action Flow will ultimately be associated with an end user menu command, so
use a name that clearly represents this flow. When you click Apply, the Action Flow
in the left pane is updated with the name you enter.
4. To add a step in the flow, click Add Step.
1505.
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5. On the right pane, under Step, type a Step Name (use any name, such as 1 or Search

Account) and then click Apply. Under the Select Action section, select an Action from the
list. If this action generates any output, select Persist Data as Output and under Action
Output section, type a Name for the output. You can use any name (like Opps). If this action
requires an input, select Provide Input and select an input from the Action Input list. Based
on the type of Action, X-Author Designer provides input suggestions. See the Action Flow
Check Boxes table below for more information on when to use inputs and outputs.

6. Repeat steps 3 – 5 to add more than one step. Ensure that you click Apply after each step

and notice the hierarchy updated in the left hand pane.
7. To reorder a step in the hierarchy, select the step from the left pane and click Step Up to

move the step up in the hierarchy. Click Step Down to move the step down in the hierarchy.
8. After you have created the Action Flow, click Save and click Save App.
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Action Flow Check boxes
Field

Description

Persist
Data as
Output

Select this check box if an action generates any output. Type a Name for the output.
You can use any name. For example, Opps.

Provide
Input

Select this check box if an action requires input. Select an action from Action Input
list. Based on the type of Action, X-Author Designer provides input suggestions.

Suppress
Save
Message

Select this check box if you have multiple save actions in a single action flow and
you want to suppress the save message of that particular action. Note: This check
box is enabled for the Save action only.
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Suppress Message Validations
When no records found in a Save
Action check box (App Settings)

Suppress Save Message
check box (Action Flow)

Behavior

Yes

No

Message is not displayed.

No

No

Message is displayed.

No

Yes

No Records Found for
Save message is
displayed.

Yes

Yes

Message is not displayed.

When all records are saved
successfully in a Save Action (App
Settings)

Suppress Save Message
check box (Action Flow)

Behavior

No

No

Message for each
Save action is
displayed.

No

Yes

Message is not
displayed.

Yes

No

Message is not
displayed.

Yes

Yes

Message is not
displayed.
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Action Flow Required Inputs and Outputs
Action

Input

Output

Check-in

Always requires an input because the Excel workbook is saved to an
individual record. Although the individual object is already identified
when you create the action itself, it is possible you could have used that
object in different ways in various action flows. Therefore, the Action
Flow requires specific output from a prior action as input to this one.

Never

Check-out

Always requires an input because the Excel file is opened from an
individual record. Although the individual object is already identified
when you create the action itself, it is possible you could have used that
object in different ways in various action flows. Therefore, the Action
Flow needs to have the specific output from a prior action as input to
this one.

Never

Clear
Fields

Never. Clear Fields is tied to a specific Save Map.

Never

Display

Always requires an input. Any object on a Display Map must be
represented by an output from a prior Action.

Macro

Never.

Never

Query

Only if INPUT has been used in the query action filter.

Always

Dataset

Always requires an input. Datasets take the outputs of query action as
inputs. Output can be saved as a single dataset.

Always

Salesforce
Method

Optional.

Optional

Save

Never.

Never
Always
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Action

Input

Output

Search
and Select

Input is required only if INPUT has been used in the Search and Select
action filter.

To edit or delete an Action Flow
1. Highlight an Action Flow on the Action Flow list.
2. Click Edit or Delete.
3. To delete an Action Flow that has already been associated with a User Menu button, first

remove the association in the User Menu.
You can auto-execute the action flow and launch an action from Salesforce as well.

To launch an Action Flow when the app is opened in runtime
An Action Flow can be kicked off automatically either when the app is opened directly in Excel or
from a Salesforce button.

When the App is opened from Excel
1. Click Action Flow.
2. Select the Auto Execute (Regular) check box for the action flow that should execute

automatically.
3. Click Cancel.

When the App is opened from a Salesforce button
There are two choices:
Follow the steps above and select the Auto Execute (Launch from Salesforce) check box
Execute a different Action Flow for each Salesforce button.
For example, if you are creating a quote from an Opportunity, you may want to execute the Create
Quote Action Flow from the Create Quote button in Salesforce. For the Edit Quote you may want a
completely different user experience so you would create a second Action Flow and attach that to
the Edit Quote button.
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Creating User Menus
User Menus allow the Designer to create menus that the end user will see in their Excel ribbon
when they open an X-Author App in runtime. There are two types of menu items:
Configurable menu buttons that execute the Action Flows.
Optional standard buttons that the Designer can use to allow the end user to add rows,
delete rows, use special paste functions, and have access to embedded X-Author Chatter.
User Menus are divided into two areas:
Groups: These divide the menu buttons into logical areas for the end user. For example, on
the X-Author Designer menu, the groups are Create, Build, Save, Migrate, and Access.
Buttons: These are the menu commands within each menu Group. At least one group and
one button within that group are required.
Standard Microsoft Excel Ribbon

X-Author Ribbon

Microsoft Icons
For icons, X-Author uses the standard Microsoft Office icon list, which can be found here:
http://www.microsoft.com/en-us/download/details.aspx?id=21103. Use the procedure below
or any other icon from the list. You must enter the icon capitalization exactly as described in
the procedure.
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To add configurable menu buttons
1. Click the User Menus button.
2. From the Add Groups and Buttons section, click Add Group.
3. Select the Default_Group entry in the left pane and from the Properties section, under

General, change the Name to the name of the group.
4. To add a button for the group, select the group from the left pane and click Add Button.
5. Under the Properties section, do the following:

In Icon, type the name of the Microsoft icon. See the Microsoft Icons.
In Name, change the default name to the name of the command.
In Order, type the order that represents the left to right position where this menu
command should appear in the group.
In Tooltip, type text for a Tooltip.
6. Select an Action Flow to be executed when the end user clicks on this menu button.
7. To activate optional standard menu buttons:

To enable the user to add records for any List Range in the App, select Display Add
Row. You will still need a Save Map for this to have any effect.
To enable the user to delete List Range records from Salesforce, select Display
Delete Row from Salesforce. You will still need a Save Map for this to have any effect.
Note: Rows are automatically deleted from Salesforce without any further Save or other
action by the user.
To enable the user to use the X-Author Chatter functionality within this App, select
Display Chatter.
8. Click Save.

Saving or Cloning an Application
After you have created or edited an application, you save the Application in Salesforce using the
Save Application menu function.
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When you save an application, a series of validations is executed to ensure that required
components have been included in your App (for example, including an ID field in a repeating
Display Map where you also have a Save Map). It then saves the changes you have made to the
Application.
The Save Application button is divided into two parts.

Click the top half of the Save Application button to save the Application. This updates Salesforce.
com with the updated template and configuration.
Always save your Application after you have completed work in any menu function (for example,
Save Map or Display Map).
Click on the bottom half of the Save Application button to Save As or Clone the Application. XAuthor suggests a new name but you can type in a name. This creates a duplicate of the App with
the new name.

Deleting an Application
You cannot delete an App using the X-Author for Excel add-in. To delete an app, you must log in to
your Salesforce org using a web browser. Note: You must have sufficient administrator privileges
to perform this task.

To delete an Application
1. Log in to your Salesforce org using a standard web browser.
2. From the Force.com App Menu, select Apttus X-Author for Excel.
3. Click on the Apps tab.
4. Click Go next to the X-Author for Excel picklist. This action displays all of the X-Author

Designer-created Apps.
5. Click Del next to the App name to delete the App, and then click OK.
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Example: Opportunities by Account App
App Objectives
The end user will search for and select an Account from Salesforce.
Based on the account selected, the app will automatically retrieve all Opportunities into
Excel.
For the Account, the app will include the Name and Phone fields.
For each Opportunity, the app will include the Name, Amount, Close Date, and Stage fields.
Allow the end user to save modifications to the Amount and Stage fields for each
Opportunity.

App Components
You will use the following app components to build your new app:
Component

Component Description

Salesforce
Objects

Account (Individual) and Opportunity (List)

Display Map

Individual and List fields per objectives

Save Map

Using fields from the Display Map

Actions

Search and Select Action for the Account
Query Action to retrieve the Opportunities for the Account
Display Action to transfer the retrieved data to the Display Map
Save Action to save back to Salesforce any user modifications

Action Flows

One Action Flow to retrieve the data and display it and one Action Flow to save
the data

User Menus

One button for the user to retrieve opportunities and one to save opportunities
to Salesforce.
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To create the Opportunities by Account App
1. In the ribbon menu, click Apps and select New Application.
2. In the App Name Field, type Opportunities by Account.
3. In the Select Template section,click the New radio button.
4. Click Create.
5. For the app type, select the product edition. For example, Enterprise.

To select Salesforce Objects
1. Click Salesforce Objects and locate Account > Opportunity and then click Add Child Object

.
2. In the right-hand window, click Account (Ind).
3. Select fields from Add Fields below area: Region, Name and Phone.
4. Click Apply. Note: You must click Apply after you have selected the fields for any object.
5. In the right-hand window, click Opportunity (List).
6. Select fields from Add Fields below area: Account Id (automatically selected for you because

this is the lookup field to the parent object in the object hierarchy), Amount, Close Date,
Name, and Stage.
7. Click Apply.
8. Click Save and Close.
9. Click Save App.

To create a Display Map
1. Select Display Maps and click Create.
2. In the Name field, type Main and from the Type list, select Individual.
3. Drag the Account Name field to C3 and Phone to C4. You will see the link between the cell

and field stamped in the bottom right-hand window.
4. Switch to List.
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5. Drag the Name field to B7, Amount to C7, Close Date to D7, Stage to F7, and Id to H7. Now

click on the orange Account iD field (with a + next to it) and it will take you to the Account
object. Select the Region field from there and drag it to G7. X-Author allows you to have
fields from any related object on the same list row.
6. Select Options and change the Sort by picklist to Name.
7. Save the Display Map and click Close.
8. Add a title to B1: Opportunities by Account.
9. Save the Display map.

To create a Save Map
1. Select Save Map and then click Create.
2. In the Name field, type Main.
3. Click Add Display Map Fields and select Amount and Stage.
4. Click Apply and then click Save.
5. Click Save App.

To create a Search and Select Action
1. In the main ribbon under Actions, click the arrow and select Search and Select.
2. In the Action Name field, type Select Account.
3. From the Salesforce Objects list, choose Account.
4. In the Search window, click the check box next to Name.
5. In the Name in Fields to Display in Search Results, click the check box next to it and the

Sort check box to the right.
6. From the Results area, choose Single.
7. Click Save.
8. Click Save App.

To create a Query Action
1. Click the arrow under Actions on the X-Author for Excel ribbon and select Query.
1612.
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2. In the Action Name field, type Query Opportunities.
3. From the Object list, choose Account.Opportunity.
4. In the Filters section, click the lookup icon and select the account id field to restrict the

Opportunity records to those that match the Account that was selected by the user. Because
this is a lookup field, click just to the right of the orange field to select the row and click Apply
. Select the other parameters based on the table below.
Salesforce Object
and Field

Value
Type

Operator

Value

Account ID

Input

Equals

Account Id from the Accounts object will
default. (Account.AccountID)

5. Click Save.

To create a Display Action
1. Click the arrow under Actions and select Display.
2. For the Action Name, type Display Opportunities.
3. From the Display Map list, choose Main.
4. Click Save.
5. Click Save App.

When data has been retrieved from Salesforce, it is placed in Excel memory, waiting to
be placed into the specific worksheet based on a Display Map. You may want to display
different maps at different times when your App is in use, so a Display Action lets you
decide which map to use and when to use it.

To create a Save Action
1. Click the arrow under Actions and select Save.
2. In the Action Name field, type Save Opportunities.
3. From the Save Map list, select Main.
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Now that you have created your actions, you need to create Action Flows to retrieve and display
data and to save data.

To create a flow to retrieve and display Opportunities
1. Click Action Flow and then click Create.
2. Enter Retrieve Opportunities into the Action Flow Name field and click Apply. The left-hand

window is updated.
3. Click Add Step.
4. In the Step Name field, type Select Account. From the Action list, select Select Account.
5. Select the check box next to the Persist Data as Output check box and enter Account in

the Action Output field.
6. Click Apply and then click Add Step.
7. In the Step Name field, type Query Opportunities.
8. From the Action list, select Query Opportunities.
9. Select the check box next to Persist Data as Output and enter Opps in the Action Output

field.
10. Select the check box next to Provide Input and then select Account from the picklist.
11. Click Apply and then click Add Step.
12. In the Step Name field enter Display Opportunities and select Display Opportunities from

the Action list.
13. Select the check box next to Provide Input and select Account and Opps from the Action

Input list.
14. Click Apply and then click Save.
15. Click Save App.

To create a flow to save Opportunities
1. Click Action Flow and then click Create.
2. In the Action Name field type Save Opportunities and then click Apply.
3. Click Add Step and from the Action list choose Save Opportunities.
4. Into the Step Name field, enter Save Opportunities and click Apply.
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5. Click Save.
6. Click Save App.

The final step is to add the end-user menus.
The workflow to add end-user menus is as follows:
1.

You first add a Group and highlight the group to add buttons underneath it.
For each group or button, you can change the names of each by overwriting the
Default Group or Display Item in the right window.
When you add a button, Order is the order in which the buttons will appear on the end
user menu.

Action Flow is for associating a menu item to the Action Flow that will be executed by
the end user.
For icons, X-Author uses the standard Microsoft Office icon list which can be found
here: http://www.microsoft.com/en-us/download/details.aspx?id=21103. Use what is
provided in the procedure below or any other icon from the list. You must enter the
icon capitalization exactly as it is described in the procedure below.
The steps to add end-user menus are described in detail in the following sections.

To create User Menus
1. Click User Menus.
2. Click Add Group.
3. In the Name field, enter Opportunities and 1 in the Order field.
4. Click Add Button and in the Name field enter Retrieve Opportunities.
5. In the Icon field enter "GetExternalDataFromOtherSources".
6. Enter 1 in the Order field.
7. From the Action Flow list, select Retrieve Opportunities.
8. Click on Opportunities to highlight the group and then click Add Button.
9. In the Name field, enter Save Opportunities.
10. In the Icon field, enter SaveObjectAs .
11. In the Order field, enter 2.
12.
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12. From the Action Flow list, select Save Opportunities.
13. Click Save
14. Click Save App.

Improving the appearance of end-user menus
1. Enlarge the title.
2. Highlight the row headings.
3. Identify to the end-user the columns or cells that are modifiable by highlighting them in a

different color.
4. You can delete the text in brackets. This does not remove the fields because those are in the

map. This just makes the presentation more pleasing.
Make sure to place your cursor in the cell and use the Delete key. Do not use row delete!
After you follow all the procedures in this section, a new App with the name Opportunities by
Account has been created.

Example: Opportunity Forecast Application
App Objectives
1. The end-user invokes all opportunities, for which they are an owner, from Salesforce into

Excel.
2. For each Opportunity include: Name, Amount, Close Date, Stage, and Owner Id.
3. Allow the end-user to save modifications to only the Amount and Stage for each Opportunity.

App Components
You will use the following app components to build your new app.
Component

Component Description

Adding Salesforce Objects to
your App

Opportunity (List)
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Component

Component Description

Display Map

Opportunity Fields as above

Save Map

Using fields from the Display Map

Customizing the App
Experience

Execute Query Action with a restriction on "Owner ID"
Display Action to transfer the retrieved Opportunity data
to the Display Map
Save Action to save back to Salesforce any user
modifications

Executing Actions

One to retrieve opportunities and one to save them

Creating User Menus

One button for the user to retrieve opportunities and one to save
them

Creating the Opportunity Forecast Application
Application creation is a multi-step process, starting with naming the app and ending with the
creation of your end-user menus. The steps are:
1. Create the new App.
2. Select Salesforce Objects to use in the app.
3. Create a Display and Save Maps.
4. Create Query, Display, and Save actions.
5. Create and Action Flow.
6. Create end-user menus.

The steps are described in detail in the following sections. You will complete each step as you
build your Opportunity Forecast app.

Prequisites
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You must be connected (through the X-Author Designer) to a Salesforce org that is
enabled for X-Author for Excel.

To create the Opportunity Forecast App
1. In the ribbon menu, click Apps and select New App.
2. In the App Name Field, type Opportunity Forecast and in the Select Template section, click

the New radio button.
3. Click Create.
4. Select edition. For example, Enterprise.

To select Salesforce Objects
1. In the ribbon menu, click Salesforce Objects.
2. In the Objects list, locate Opportunity, either by scrolling or by typing in the first letter to jump

to the nearest match and then scrolling.
3. Click Add Parent Object. This will always be true if you have just one object. The object is

now in the selected box on the right and is automatically assigned default List behavior.
4. In Add Fields below, select the following field names: Account ID, Amount, Close Date, Name

, Owner ID, and Stage.
5. Click Apply.

Note: You must click Apply after you have selected the fields for any object or these will not
be saved if you have more than one object.
6. Click Save and Close.
7. Click Save App.

To create a Display Map
1. Click Display Map and select Create.
2. In the Name field, type Main and from the Type drop-down, select List.
3. Drag the Account Name field to A7. This field was not an available in Salesforce Objects, but

X-Author for Excel automatically includes the Name field for any lookup field selected in
Salesforce Objects.
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4. Drag Name to B7, Amount to C7, Close Date to D7, Stage to F7, Opportunity Id to H7.
5. Click Options and change the Sort by list to Account Name.
6. To save the Display Map, click Save and then click Close.
7. Add a title in A1, for example, Opportunities Forecast.
8. Save the App.

To create a Save Map
1. Click Save Maps and select Create.
2. In the Name field, enter Main.
3. Click Add Display Map Fields and select Amount and Stage.
4. Click Apply and then click Close for the Save Map.
5. Click Save App.

To create a Search and Select Action
1. Click the arrow under Actions on the menu and select Search and Select.
2. Enter Select Account into the Action Name field.
3. Choose Account from the Salesforce Objects list.
4. Click the check box next to Name in the Search window.
5. Click the check box next to Name in Fields to Display in Search Results and the Sort

check box to the right.
6. Choose Single from the Results area.
7. Click Save.
8. Click Save App.

To create a Query Action
1. Under Actions, click the arrow and select Query.
2. In the Action Name field, type Query Opportunities and from the Object picklist select

Opportunity.
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3. In the Filters section, select or enter the following to restrict the Opportunity records to those

for which the current user is the Opportunity owner. Click the lookup icon
and select the
Owner Id field. Because this is a lookup field, click to the right of the orange field to select
the row and click Apply. Select the other parameters based on the table below.
Salesforce Object and Field

Value Type

Operator

Value List

Owner Id

SystemVariables

Equals

CurrentUser

4. Click Save.
5. Click Save App.

To create a Display Action
1. Click the arrow under Actions and select Display.
2. Enter Display Opportunities into the Action Name field.
3. Choose Main from the Display Map list.

When data has been retrieved from Salesforce, it is placed in Excel memory, waiting to
be placed into the specific worksheet based on a Display Map. You may want to display
different maps at different times when your App is in use, so a Display Action lets you
decide which map to use and when to use it.

To create a Save Action
1. Click the arrow under Actions and select Save.
2. Enter Save Opportunities into the Action Name field.
3. Select Main from the Save Map list.
4. Click Save.
5. Click Save App.

Now that you have created your actions, you need to create Action Flows to retrieve and display
data and to save data.
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To create a flow to retrieve and display Opportunities
1. Click Action Flow and then click Create.
2. In the Action Flow Name field, type Retrieve Opportunities and click Apply. The left-hand

window is updated.
3. Click Add Step.
4. In the Step Name field, type Query Opportunities.
5. From the Action list, select Query Opportunities.
6. Check Persist Data as Output.
7. Enter Opps, then click Apply.
8. Click Add Step.
9. In the Step Name, enter Display Opportunities.
10. From the Action list, select Display Opportunities.
11. Check Provide Input and choose Opps as default.
12. Click Apply and then click Save.
13. Click Save App.

To create an action flow to save Opportunities
1. Click Action Flow and then click Create.
2. In the Action Flow Name field, enter Save Opportunities and click Apply. The left hand

window is updated.
3. Click Add Step and in the Step Name field, enter Save.
4. From the Action list, select Save Opportunities.
5. Click Apply.
6. Click Save.
7. Click Save App.

The final step is to add the end-user menus. Creating menus is a multi-step process.
You first add a Group and highlight the group to add buttons underneath it.
For each group or button, you can change the names of each by overwriting the Default
Group or Display Item in the right window.
170

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

When you add a button, Order is the order in which the buttons will appear on the end-user
menu.
Action Flow is for associating a menu button to the Action Flow that will be executed by the
end-user.
For icons, X-Author uses the standard Microsoft Office icon list which can be found here:
http://www.microsoft.com/en-us/download/details.aspx?id=21103. Use the icons described
in the procedure below or use any other icon from the list. You must enter the icon name,
including capitalization, exactly as it is documented in the procedure below.
The steps are described in detail in the following sections.

To create User Menus
1. Click User Menus.
2. Click Add Group.
3. In the Name field, type Opportunities and 1 in the Order field.
4. Click Add, and in the Name field, type Retrieve Opportunities.
5. In the Icon field, type "GetExternalDataFromOtherSources" and in the Order field enter 1.
6. Select Retrieve Opportunities from the Action Flow list.
7. Click on Opportunities to highlight the group and then click Add Button.
8. In the Name field, type Save Opportunities.
9. In the Icon field, type "SaveObjectAs" and in the Order field enter 2.
10. From the Action Flow list, select Save Opportunities.
11. Click Save.
12. Click Save App.

To make the end-user menus look presentable
1. Enlarge the title.
2. Highlight the row headings.
3. Identify to the end-user the columns that are modifiable by highlighting them in a different

color.
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4. (Optional) You can delete the text in brackets. This does not remove the fields because

those are in the map. This just makes the presentation more pleasing.

Make sure to place your cursor in the cell and use the Delete key. Do not use
Delete Row.

An App with the name Opportunities Forecast has been created. Now you can run it by clicking the
Preview button in the ribbon menu.
The user menus you created now appear in the ribbon. Click the Retrieve Opportunities button
and the list of opportunities is displayed. Make a few changes. Click Save Opportunities, and you
will see a message that the records were saved. The changes are reflected in Salesforce.
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Previewing Apps
You can use the Preview function in X-Author Designer to preview your app. Preview allows you
to test the app as a runtime user.

To preview an app
1. After creating an app, click the Preview button in the ribbon menu.

The app opens in the X-Author for Excel tab.

When you click Preview, a new worksheet opens and X-Author for Excel must
reconnect to the Salesforce org. This may take a few seconds.
2. In the ribbon menu, click the Retrieve button to download data from Salesforce into Excel.

You can now test your app by retrieving data and adding, pasting, and deleting rows.

Example of previewing an app
In this example, we will preview a parent-child app (Accounts and Opportunities, respectively) that
allows us to search by Account Name or Billing City. This is what our app looks like when it first
opens.
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In this example, Display fields are indicated by the blue background and Save fields are indicated by the
green background. These colors can be set when creating apps.

When you click the Retrieve button, the Search Account window opens. (Account is the parent
object in our app.)
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Notice that you can search by Account Name and Billing City. These are the fields that were set as
Search fields for the Accounts object when the app was designed.
Notice that the Account Name, Billing City, Billing Country, and Last Activity fields are all displaying
in the results panel. These are the fields that were set as Results fields when the app was
designed.
If you want to see all Opportunities for only the Toronto office of Global Media, you can type search
text into both search fields.
To search all available search fields at one time, you would type your search text in the Search
Across Filters text box.
For this example, we will search for all opportunities in Toronto, Canada.
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Double-click the search result you want to retrieve data from, or select a row and click Next. The
Search Opportunities window opens. (Opportunities is the child object in our app.)

Again, all of the search fields available on this page are the fields that were configured to be
search fields for the Opportunities object when the app was created. You can use these search
fields to narrow your results.
In our case, we want to retrieve all three of the opportunities that were retrieved, so we will click
the Select All check box and click Next.
The search window closes and our data is retrieved and added to our Excel worksheet.
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Activating and Assigning Apps
After you have created an app, you need to activate the app in Salesforce and assign it to runtime
users.

About Activating Apps
After you create an app in X-Author for Excel, the app must be activated in Salesforce.

To activate apps
1. Log in to Salesforce.
2. In the Force.com app menu, click X-Author for Excel.
3. Click Apps.
4. Click Edit next to the newly created app.
5. Click the Activate check box and click Save.

The app has been activated. Now you can assign it to users.

Assigning Apps to Runtime Users
Now that you have activated the app, you need to assign it to runtime users. Assigning the app
allows specific users or users with specific profiles to access the app in the X-Author for Excel
ribbon menu in Excel.

Note
If the Assign button is not available on the Apps page, an administrator must add it to the
layout. Refer to Completing Designer Setup for instructions.
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To assign apps to runtime users
1. Login to Salesforce.
2. In the Force.com app menu, click X-Author for Excel.
3. Click Apps.
4. Click Assign next to the newly created app.
5. Check the boxes for the appropriate users or profiles.
6. Click Save.

If you have large number of users in your organization, as an alternative to the manual steps listed
below, you may contact your Apttus representative for a copy of the X-Author App and App
Assignment application. This app was built to enable Admins to quickly assign Users or Profiles to
any X-Author for Excel App.
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Managing Apps
Refer to the following sections to help you manage settings for your apps, import and export apps,
and use apps to migrate data between Saleforce orgs.

Application Settings
The following options are used to affect the runtime user experience, use protected worksheets,
and secure Excel file saving and printing.

Disabling the Save and Print Menus
To prevent a runtime user from using the Save, Save As, or Save and Send sub-menus of an
Excel File menu, click Disable Local Save File.
To prevent a runtime user from using Microsoft Excel's Print menu, click Disable Print.
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Disabling Rich Text editing
To prevent a runtime user from adding and editing rich text data, click Disable Rich Text editing.
Use this option when you want the rich-text field HTML to be populated in the cells rather than links
that allow the user to add or edit rich text. For more information about rich text editing, refer to Rich
Text Fields.

Ignoring Picklist Validation on Save
To prevent validation of picklist data during Save Actions: Use this option when you want the
picklist validation to be ignored when saving the data back to Salesforce in runtime.

Suppressing Messages
Select these options to suppress messages for the specific conditions described.
Field

Description

When no records are retrieved
from a Query Action

Select this check box if you want to suppress the messages
when no records are retrieved from a Query Action.

When no records are retrieved
for a parent object from a Query
Action

Select this check box if you want to suppress the messages
when no records retrieved for a parent object from a Query
Action.

When no records are found to
save in a Save Action

Select this check box if you want to suppress the messages
when no records are found to save in a Save Action.

When all records are saved
successfully in a Save Action

Select this check box if you want to suppress the messages
when all records are saved successfully in a Save Action.

Using Protected Worksheets
All Excel sheet protections work with X-Author for Excel provided the password for each protected
sheet has been entered. Any worksheets that have been protected will be displayed in the Protect
Sheet Setting window. Enter the password for each sheet and click Save.
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All the options of the protection settings are now supported per sheet. The protection settings are
remembered (per sheet) even if you unprotect the sheets. The protection settings are reapplied
when you re-protect the sheets back. X-Author for Excel will not allow the addition of rows or
columns in a protected sheet.

To protect a sheet
1. Right-click on the sheet that you want to protect and select Protect Sheet.
2. Set the permissions by selecting appropriate check boxes.
3. Enter the password in Password to unprotect sheet text-box.
4. Click OK.

Note
You will receive a validation message when you provide a wrong password in App
Settings in order to protect the sheet. The name of the sheet is also provided with the
validation message.
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Max Attachment Size Limits
Salesforce has a File Size Limit which limits the size of the attachments to be uploaded for a single
record on Salesforce. For more information regarding attachment limits refer, File Size Attachment
Limits in Salesforce.
If you increase the file size limits in Salesforce, you can set the file size limit per attachment in a
record in X-Author for Excel. Navigate to App Settings and set the Max File Size limit. This limit
indicates the maximum size of an attachment that can be uploaded to Salesforce.
Suppose the records in your application comprise the attachment field and have multiple
attachments. During insert or upsert, the insert or upsert transaction request is chunked into
multiple Salesforce transactions so that all the attachments are inserted or upserted successfully.

Color for Unsaved Records
During runtime when a record is not saved due to an error, the following events occur:
For a cell: The cell corresponding to the field in the Save map is highlighted based on the
selected color.
For a row: The row containing the error record is highlighted based on the selected color.
Set the color you want for the unsaved records or fields in App Settings.

Syncing Apps
Use the Sync App action from the Admin section of the X-Author Designer ribbon to review and
correct discrepancies between your app and Salesforce data. This feature replaces the previous
Validate feature in the ribbon.
Using Sync App, you can view and correct the following data mismatches between your app and
Salesforce:
Objects – View all objects in your app that do not match objects in the connected
Salesforce org. You must manually remove these objects from your app or add or make
them available in Salesforce.
Fields – View all fields in your app present in one or more Display Maps, Save Maps or
Search Filters that do not match objects in the connected Salesforce org. Use Sync App to
select and remove these fields from Display Maps and Save Maps. In most cases you must
manually remove fields from your search and query filters.
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Field Data Types – View all mismatched field data types that exist in your app. Use Sync
App to correct all mismatched data types in your app with data types from Salesforce.
Picklists – Review the total number of Picklist fields (not values) synced between the app
and Salesforce (based on Salesforce data) in the Summary. No user intervention is
required.

Missing/Inaccessible Objects and Fields
Keep in mind that when you sync apps, some mismatches may be displayed because
your user profile or individual permissions do not allow you to access them. Before
taking any action based on the Sync App dialog, check with your administrator to
make sure that no permission issue exists that is preventing you from accessing
objects or fields used in the app.

Note
The Sync App feature is not compatible with Quick Apps.

To view and sync missing or inaccessible objects
1. From the X-Author Designer ribbon, open the app you want to sync.
2. From the Admin section of the X-Author Designer ribbon, click Sync App.

3. Review the Sync App summary. Click the link next to Objects in the Summary or on #

Objects in the sidebar.

184

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

4. Review the Missing or Inaccessible Objects screen. This screen displays a list of Object

Names and Ids that exist in your app but do not match objects in the connected Salesforce
org (either because they do not exist or you do not have access). The total number of object
mismatches is displayed in the Sync App dialog sidebar (for example, "2 Objects").
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5. To sync your app with Salesforce, you must manually remove the objects from your app

(using Salesforce Objects) or add them in Salesforce. If you determine that an object was
displayed due to a permissions issue, a Salesforce administrator must modify permissions
for the specified object.

It is strongly advised to sync fields before manually removing any objects from your
app, as fields from the object you want to remove may be used in Display Maps,
Save Maps or Search and Query filters (see below).

To view and sync missing or inaccessible fields
1. From the X-Author Designer ribbon, open the app you want to sync.
2. From the Admin section of the X-Author Designer ribbon, click Sync App.
3. Review the Sync App Summary. Click the link next to Fields in the Summary or on # Fields

in the sidebar.

4. Review the list of missing or inaccessible fields. This screen displays all of the fields that

exist in your app that do not match a field in the connected Salesforce org for a given object.
For each field, the Display Map, Save Map and Search Filters columns indicate whether the
field is used in one or more Display Maps, Save Maps or Search/Query Filters, respectively.
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5. Double-click on a row to display a pop-up and to view all areas of the App with that field.

6. If you decide to remove any of the fields in the list from your app, click one or more check

boxes corresponding to the fields you want to remove and click Remove.

Fields used in Search & Select and Query filters are only removed in this way if the
filter type is "User Input" and there is no Filter Logic defined. In all other cases, you
must go to the filter and manually remove it from your app.
7. Click OK to close the Sync App dialog.
8. Click Save App to save the changes you made to your app.

To view and sync field data types
1. From the X-Author Designer ribbon, open the app you want to sync.
2. From the Admin section of the X-Author Designer ribbon, click Sync App.
3. Review the Sync App Summary. Click the link next to Field Data Types in the Summary or

on # Field Data Types in the sidebar.
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4. Review the list of mismatched field data types.
5. Double-click on a row to display a pop-up and to view all areas of the App with that field.

6. To sync incorrect data types with the data types in Salesforce, select on or more check

boxes and click Sync Fields.
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7. Click OK to close the Sync App dialog.
8. Click Salesforce Objects to verify that the field types have been properly synced.

9. Click Save App to save your changes.

Best Practice
After you have performed all Sync App operations, choose Sync App again to doublecheck that there are no more mismatches or discrepancies to validate against Salesforce.
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Importing and Exporting an Application
X-Author for Excel Apps can be easily migrated from one Salesforce org to another provided that
the Salesforce objects being used in the exporting org match those in the importing org.
The Import function imports a previously exported App into the Salesforce org to which you are
connected.

To import an app
To import a previously exported X-Author for Excel .app file follow the steps below:
1. Click Import.

2. To browse for the Application to import, click Browse App.
3. From the X-Author Application Import dialog, select the file with an .app extension and click

Open.
4. Under App Details, in Import App Name, change the name of the App, if required, and click

Import.

The App is imported into your current Salesforce org.
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Best Practice
To avoid errors using the app in the new org, make sure to click Sync App after the
import is complete. This will identify any existing mismatches in objects and fields defined
in the app. If you do encounter errors upon validation, check the objects and fields
affected. Make changes to your app or in your org as needed, and perform the import
process again.

To export an app
1. Click Export.

2. Choose a location and enter a filename.
3. Click Save.

An app file with .app extension is saved at the chosen location. The Export function saves an App
as an .app file. This file can then be used by the Import function to add that App to a different
Salesforce org. You should also use this function to back up your apps while creating them.

Migrating Data Between Salesforce Orgs
Refer to Using the Data Migration Wizard for step-by-step instructions using the Data
Migration Wizard to create an app for data migration between orgs.
Migrating data requires the following functions:
Source Data provides a mapping mechanism for helping to migrate data between
Salesforce orgs.
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It is combined with the Paste from Mapping menu option in runtime or Paste Source Data
action function to copy data from an entire workbook to another workbook in the desired
format.
The most common use case for this is for migrating data from one Salesforce org to another far
more easily and quickly than can be done with the traditional single object data loading tools. The
source App is for downloading all the data you need to migrate. Each object can be represented in
one worksheet for example. The target app is a replica of the source app except it is for uploading
data to the target org. The Source Data function provides the mapping between the Apps.
You could also choose to create a more advanced single app that handles both the source
download and target upload. For this you would need to make use of both the Switch Connection
and Clear Actions as well.

To use Source Data to migrate data
1. Open the source App in X-Author Designer and make a note of the starting cell location for

each range of data that needs to be copied.
2. Click File > Save As and save the file to your local drive. Use any file name.
3. Open the target App in X-Author Designer and click Source Data on the menu.

4. Select Source Excel Sheet, locate the file above and click Open.
5. Use the drop-down menu under Source Sheet to select a worksheet.
6. In the Source Range enter in the starting range cell location for that worksheet.
7. Use the drop-down menu under Target Sheet to select a worksheet.
8. In the Target Range enter in the starting range cell location for that worksheet.
9. Repeat these steps for each of the other worksheets.

The starting cell in the Target Range must be one row below where you have your fields
mapped. So if you have all fields mapped in A3:J3 for example, the Target Range would
be A4.
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The Paste from mapping function in runtime will copy all data in the list range from the
source based on the source range starting location. For example, if you have a data
range from A3:J3, it will copy all cells in that range into the target App.

Using the Data Migration Wizard
X-Author for Excel provides a built-in solution for migrating data from one Salesforce org to another
with the Data Migration wizard. Using the Wizard, you can choose Objects, Fields and related
Lookups to build an app configured to retrieve data from the connected source org and save data
to a target org. The wizard takes care of all Display Maps, Save Maps, Action Flows and user
menus so you have an app ready to use when you are done. As a designer, you can also
customize the app after completing the wizard steps to tailor it to your requirements.

Certain restrictions apply to app design after you have completed the Data Migration
wizard. Consult the following sections for a list of restrictions.

To start building a new Data Migration app using the Wizard
1. Go to the X-Author for Excel Designer tab and Connect to your Salesforce org.
2. From the X-Author for Excel Designer ribbon, click on the arrow next to Data Migration.

3. Click New to open the Data Migration Dashboard.
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4. Enter an App Name for your Data Migration app.

Next step: Add some objects and fields.

Adding Objects and Fields to your Data Migration App
To begin building your Data Migration app, you need to configure which Objects and Fields should
be part of the migration. If you are working with an existing Data Migration app, you can make
changes to the Objects and Fields already present in the app in the same way.
When you create a new Data Migration app or edit an existing one, the following screen is
displayed.
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To Add Objects to your App
1. From the upper right-hand corner of the screen, click on Add Objects.

2. Double-click on an Object or highlight and Object and use the arrow button to add Objects to

your app. To refine the list of Available values, click on Search.
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3. Click Save to add the selected Objects to your app. The Data Migration Dashboard updates

with an entry for each Object you added.
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Note
Do not worry about the sequence of Objects in your app at this time. Sequence will adjust
depending on how External ID and Lookups are set.

To Add Fields to your App
After at least one Object has been added to your Data Migration app, you can add fields for each
selected Object.
1. From the Data Migration Wizard screen, click on the link under the Fields column

corresponding to the Object you want to work with.

2. Select the check box for each field you want to add to your app. To refine the list of fields,

enter text into the Search field. Note: You cannot deselect the Object fields ID or Name.
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3. Click Apply to add fields to your app for the selected Object.
4. Repeat steps 1 – 3 for each Object in your app, as required.

If Fields for one of the Objects in your app have been previously added, you can click the
hyperlink under the "Fields" column to add or remove more Fields.

Working with the Data Migration Dashboard
After adding Objects and Fields to your app, you can take the following actions as needed:
Specify a unique Display Name for each Object in the app.
Click on the link under the Fields column to add or remove more Fields for an Object.
Click on the link under the Lookup Fields column to add or remove more Lookup Fields for
an Object.
Click on the
Copy icon to copy an Object listing and modify it as required (for example,
you want to add the same Object and a different set of Fields for filtering purposes).
Click on the

Remove icon to remove an Object from your app.

Click the Display check box to enable/disable creation of a separate worksheet for the
object during migration. Refer to Configuring your Data Migration App for a complete
description.
Specify Load Sequence, Actions, and Filters. Refer to Configuring your Data Migration
App for step-by-step instructions for these tasks.
Next: Add Lookups to your app.

Adding Lookups to your Data Migration App
In addition to Objects and their Fields, you can also add Lookup fields that reference other Objects.
The Lookup Object can only be referenced if it has been included in the fields for that Object in
Salesforce. Also, fields already added to your app will not be visible in the Lookup dialog.
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To add Lookup Fields to your App
1. From the Data Migration screen, click on Add Lookups.

2. Navigate the Object/Field tree and select a check box to add one or more Lookup fields to

your app. Click the check box next to an Object name to select all Lookup fields for that
Object. Fields that have already been added to your app are not displayed.
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3. Click Add to add all selected Lookup fields to your app.
4. Click OK. The Lookup fields are added to all related Objects in the app. When Lookup fields

are added:
Each affected Object displays the number of Lookup fields that will be migrated when
the app is run.
Fields representing the Lookup fields are added to the Object under the "Fields"
column.
You can click on the link under the "Lookups" column to view all Lookup fields added
for a specific Object.
The Object sequence is automatically adjusted based on Lookup relationship
between Objects (the sequence for dependent Objects are changed).
A filter (see below) is automatically created for the Object. Do not remove this filter
or you will encounter errors during migration.
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Specifying the Lookup Source for Multiple Data Sets
When your action flows require queries to multiple data sets for the same lookup object, you can
choose which object to use as the lookup source for each lookup field added to a data migration
object.

To create more than one lookup source to the same object
1. Add at least two lookup fields to your data migration object that look up to the same object.
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2. From the Data Migration Wizard screen, copy the lookup object so that there are two entries

for the same object in the wizard.
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3. Change the Display Name of each lookup object to reflect the lookup source. For example,

the display name of the lookup object for the Component Product could be "Base Product"
and the display name of the lookup object for the Parent Product could be "Sub Bundle
Product."

4. Click on the Lookup Fields link for the object that contains the lookups.
5. Change the Lookup Source value to the object you want to act as the source input for each

lookup field and click Apply.
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After you create or update the wizard, check the appropriate "Export" action flow step that
corresponds to the data migration object action. Each Lookup Source you selected in the
data migration lookup window is listed under "Action Input" for the step.
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When the migration is executed at runtime, actions from each lookup source will retrieve a
combination of records based on the complete data set.

Next: Configure settings or complete app configuration.

Configuring your Data Migration App
Before your Data Migration App can be finalized and ready to use, you need to specify load
behavior, actions and filters for data retrieval.

Determining Load Sequence
By default, Salesforce Objects retrieved from the source org will load in the sequence listed on the
Data Migration screen. If you want to change the load sequence behavior, you need to specify a
new load sequence for Objects in the list.
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To accomplish this, edit the Load Sequence column for your objects. Use caution when making
changes, as load sequence is important when migrating data. Users will encounter errors, for
example, if a Child Object load sequence is specified prior to its Parent Object. Also, you cannot
finalize the app if there is a number missing in the load sequence or two or more Objects share the
same Load Sequence.

Choose a User Action for each Object
Each Object in the Data Migration must have a corresponding action in the runtime app. This
allows the user to make use of X-Author's Search and Select or Query actions to request data from
the source org during the migration.
To choose actions, click the drop-down menu next to each Object and select either Search &
Select or Query.

For both Search & Select and Query actions, the Options are automatically filled based on the
Objects and Fields you added to your app. You can make changes to these options as required
when you define Filters.

For more information on these actions, refer to Search and Select and Query actions in
this guide

Filtering Search and Select and Query Actions
To refine the data selected for migration when the user goes through the Data Migration app
Action Flow, you can specify one or more filters for each Object being migrated. The process for
defining filters is the same for each action type.
To define Filters for an action:
1. Click on the

Filter icon next to the corresponding action.

2. Define one or more filters to apply to data retrieved for the selected Object and its Fields:
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a. Use the Expression builder to specify a Value Type, Operator, and Value for your

filter.
b. Click Add Row to create an additional filter.
c. Click Add Filter Logic to specify additional logic for the filters you create.

3. Click Save when you are finished defining Object and Field filters.

When building filters, you can only create expressions for Objects and/or Fields already
added to the app.
For complete instructions on building S&S and Query filters, refer to Query Action.

Specify External ID
This is an optional step that is only required if your Object has more than one Salesforce External
ID. Most Objects will only have a single External ID, but in some cases an Object will have more
than one (for example, you export data for this object to more than one external source). Setting
the External ID is important to prevent duplication of records during data migration.

Note
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All Objects must have a set External ID. If an Object does not have an External ID set,
you will not be able to save the app. It is recommended to configure External ID's in
Salesforce for every Object that you want to migrate before creating the Data Migration
app. You can configure External ID's for your Objects in one of two ways:
Use Apttus' Metadata utility to create External IDs for each Object you want to
migrate. Contact your Apttus representative to get access.
Configure External ID's for your Objects using Salesforce. Create a text field
labeled APTS Ext ID, field name APTS_Ext_ID per configuration in the image
below. Refer to Salesforce administrator documentation for help on how to add
fields to your Objects.

You will need to restart X-Author after adding the External IDs.
When an Object has more than one External ID, a Not Set link will be visible under the "External
ID" column.

To specify External ID for an Object
1. From the Data Migration screen, click Not Set under the "External ID" column corresponding

to the Object you want to set.
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2. Using your cursor, highlight the correct External ID field to use for your Object.

3. Click Apply. The chosen External ID is updated in the Data Migration Object listing.
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Disabling Worksheets
By default, each object you add to your Data Migration app representing a Query or Search &
Select action creates a separate worksheet to retrieve data for migration. You can choose to
disable creation of a worksheet for specific objects defined in the app. To disable the worksheet for
an object, click the corresponding check box under the Display column. After you create the app,
the resulting workbook will not create a worksheet for the disabled objects. Any queries for those
objects will still execute–the output from those queries can still be used as input for other actions in
the migration).
In the below example, the "Sub Bundle Products" object query retrieves data that is then used by
the "Product Option Component" query to retrieve records for migration and populated in the
Product_Option_Component worksheet. Because "Sub Bundle Products" is only used as input for
another query, a worksheet is not required for that data.

For step-by-step instructions on creating a Data Migration Wizard, refer to Using the Data
Migration Wizard in the X-Author for Excel Designer and Runtime guide.
Next: Finalizing your app.

Configuring Data Migration App Settings
You can specify settings for your Data Migration app to customize the Action Flow, User Menus,
Filters, and place restrictions on run-time actions.
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To configure settings for your Data Migration App
1. From the Data Migration screen, click on Settings.

2. Specify values for your app settings. Refer to the table below for a list of settings and their

descriptions.

Setting

Description

Guidance

Export
All Suffix

Enter custom text to replace "All"
for the "Export All" button of the
app.

Limit the suffix to fit text in the X-Author
ribbon.

Export
Selective
Suffix

Enter custom text to replace
"Selective" for the "Export
Selective" button of the app.

Limit the suffix to fit text in the X-Author
ribbon. Suffix should represent filters
defined for your Objects.

3. Click OK to apply your settings.
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Finalizing your Data Migration App
When you are finished creating your Data Migration App, return to the Data Migration screen and
click Create App (or Update App if you are editing). The Wizard creates or updates the app based
on your specifications and displays the resulting app as shown in the example below.

When you create or update a Data Migration app it is automatically saved once you click
Create App/Update App. Please remember that if you make any additional changes to the
app. you must save the app in X-Author.

Making Changes to your Data Migration App
Since the Data Migration app is just another X-Author app, created using the Wizard instead of the
individual designer tools, most elements of the app can still be modified by the designer before the
app is finalized. Click on any of the buttons in the Designer tab to see the Display Maps, Save
Maps, Actions and User Menus created by the Data Migration Wizard.
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Be especially careful when modifying a Data Migration app after you create it with the
Wizard. Because the app is assembled using the Wizard, you may inadvertently break the
functionality if you modify maps or remove other components. If you want to add or
modify any Objects or Fields, it is recommended to Edit the app using the Data Migration
Wizard (see below), rather than editing Display/Save Maps and other elements of the app
directly.
Add Custom Actions or User Menus to your app as required to finalize your Data Migration App.

Editing your Data Migration App Using the Wizard
When you want to modify a Data Migration App to add, remove or change Objects, Fields,
Lookups, or change Filters and other settings, go to the Data Migration Wizard and select Edit.

If the changes you want to make to the Data Migration App are significant enough, it is
recommended to create a new app rather than modify an existing one.
Please note that you cannot change the following components of an app when you are editing it:
App Name
User Actions
External ID
If you want to make changes to any of the above, you can still remove an Object from the app and
add it back again, making any changes as required.

213

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

Performing the Data Migration
This page provides instructions for performing a Data Migration from one Salesforce org to another
using an app created with the Data Migration Wizard. Instructions may vary slightly depending on if
any customizations were made to the app outside of the Wizard. For help with specific user actions
or action flows, refer to the appropriate section in this guide.

Prerequisites
The app to be activated for use by the user doing the migration.
The user must also have access to the X-Author for Excel Designer tab.

To perform a data migration
1. From the X-Author Designer tab, export the app to your computer and Import the app to the

Salesforce org where your source data resides. Follow the instructions under Importing and
Exporting an Application, then move to step 2 on this page.

Import Best Practice
To avoid errors using the app in the new org, make sure to click Sync App (from
the Admin menu) after the import is complete. This will identify any existing
mismatches in objects and fields defined in the app. If you do encounter errors
upon validation, check the objects and fields affected, make changes to your app or
in your org as needed, and perform the import process again.
2. Click on the X-Author for Excel tab to switch to the runtime view.
3. Select App > (your Data Migration App Name) to open the app.
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4. Populate the app by choosing one of two options:

Export Selective - Choose this action if you want to search for and select specific
records to export from the source org for each Object in the data migration app. After
making your selections, click Next to retrieve data into the app.

Use this option when there are Filter criteria defined for any of the Objects
in the app. User actions defined for Objects in the app (like Search &
Select) only execute when this option is chosen.
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Export All - Choose this action if you want to export ALL records from the source org
for each Object in the data migration app. No filters are applied.

Note
This option may take an unusually long amount of time to retrieve data if
there are a large number of records in your Org.

5. From the Source Org section of the X-Author Excel tab, click Save Source Data.
6. Browse to a location on your system to save the workbook. Name the file and click Save. All

data retrieved by the Export action is saved to the app.
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7. Close the app.
8. From the X-Author Designer tab, click on Switch Connection and select the target org for

data migration. Enter your credentials and connect.
9. You must now import the Data Migration app you exported in Step 1 into the target org.

Select Migrate > Import and browse to the app file.

10. Click Import. Verify the app imported successfully and click OK.

11. Click on the X-Author for Excel tab to switch to the runtime view.
12. Connect to the target org.
13. Click on Apps > Open App and open the imported app.
14. From the Edit section, click on Paste and select Paste from Mapping.
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15. Browse to the app file save in Step 5 (saved source data) and click Open.

Note
Source data that you exported is pasted into the app without Target Record ID.
Record IDs will be assigned to all new records that are created when you migrate
that data to the Target Org (but will not be represented in the app).
16. From the Target Org section of the ribbon, click Save All. The exported records from the

source org are migrated to the target org. Depending on how much data you are migrating,
this can take some time. When data migration is complete, a separate success message is
shown for each Object being migrated. Click on Show details to view details.
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Note
The success message may not be shown if settings have been changed in XAuthor Excel to suppress messages. Refer to Application Settings for more
information.

Updating Records during Migration
As part of the migration, you may choose to update (or upsert) existing records in the target org
with updated data from the source org. In this case, you are updating or upserting data from the
source org records to target org records. You do this by modifying the exported data from the
source org prior to migration. You can also update/upsert records following the initial migration by
reusing source data in a subsequent migration. The following use case shows an example of this.

Use Case: Updating Records after Migration
Diana Designer has performed an initial migration of data from a source production org to
a target production org. After the migration, she decides that she would like to perform
some updates to some Opportunities in the migration. Diana can use X-Author
functionality to update (or upsert) records by modifying the same source data she used
during the initial migration.
She performs the following steps to update the migration data:
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1. Diana connects to the Target Org and reopens the Data Migration app in X-Author

for Excel Runtime.
2. She selects Edit > Paste from Mapping. Diana browses to the source data

workbook from the previous migration and opens it in the app. The Account
worksheet is displayed.

3. Diana chooses to update some Account phone numbers.

4. She then moves to the Opportunity worksheet.
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5. Diana modifies some Opportunity amounts.

6. Diana selects Target Org > Save All. She has successfully upserted the migrated

records.

Note
You can also add rows using the method to Insert new records. Because the workbook is
protected, you must copy an existing row, use the "Paste Values Only" action from the XAuthor ribbon and make changes (remember to remove the Target Record ID if one is
displayed).
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Using Advanced App Design
The following sections provide step-by-step instructions for advanced app design features.

Creating External Actions
Over and above the standard actions, Designers can include their own actions through the
External Library capabilities. This requires the use of the X-Author SDK libraries to create custom
DLLs. For example, you could create an external action for something as simple as record data
cleansing, or something more complex such as invoking Oracle or SAP web services.

Prerequisites for creating Actions
An Integrated Development Environment that enables you to build DLLs. In the example in
this procedure, Microsoft Visual Studio is used to describe the setup process for External
Actions.

How to design an External Action
1. Create a Visual Studio Class Library Project. The X-Author client installer includes a sample

C# file.
The code sample shows the functions to use and it will pop up a message box in runtime.
You can extend the Execute() function to write your custom logic using the full power of
Visual Studio and .NET.
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2. Add a reference of the Apttus.XAuthor.ExtensionLib module into the project. The Apttus.

XAuthor.ExtensionLib action class which represents an action is available for external use in
this SDK Library. Any user who designs a new action, needs to add a reference of this
library in their Visual Studio project. This library extends the following:
Action Class extends the capabilities of the Base class capabilities to the custom .cs
file.
IActionRuntime interface invokes the execute method defined in a custom .cs file.
3. Provide Name and Type for the external action and provide custom logic for the Execute()

function.
4. Compile and link the assembly to generate the output .NET assembly. The .NET assembly

should be a .dll file.

using
using
using
using
using
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using Apttus.XAuthor.Core;
using System.Xml.Serialization;
using System.Runtime.InteropServices;
namespace TestExternalAction
//Apttus.XAuthor.Core.Action is the base class of the module
for which the capabilities are extended. Using the
IActionRuntime interface invokes the custom execute method.
{
public class FirstExternalAction : Apttus.XAuthor.Core.
Action, IActionRuntime
{
//Custom class. You can define any object that you
choose in your class.
public FirstExternalAction()
{
Name = "First External Action";
Type = "External Message Action";
}
//Defining the logic on execution of the external
action.
public ActionResponse Execute(ActionRequest request)
{
ActionResponse r = new ActionResponse();
System.Windows.Forms.MessageBox.Show("External
Action : Executed");
r.Status = ActionResultStatus.Success;
return r;
}
}
}

The sample *.cs file can contain one or more external actions.

How to link an External Library into X-Author
After developing an External Action that is part of a library (.NET assembly), load the library into XAuthor Designer using the following steps.
1. Navigate to the X-Author for Designer Tab.
2. Click External Library, load the required .dll file and click OK.
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After you load the selected assembly, X-Author detects all the external actions within that
assembly.
3. Invoke the newly created external actions within an Action Flow just like built-in actions.

To update an existing external library
To update and link a new version of the library into X-Author, ensure that any external actions
within that library are not in use in any Action Flow. You can update an existing external library
only under certain conditions.

How to remove an existing external library
A user can remove an already linked external library. To remove an existing library, open the
existing library and select a row and click Unlink Library. An External Library can only be removed
if any of the External Actions exported in the library is not used in an Action Flow.

Creating Look Aheads
Look Aheads allow designers to create field lookups for runtime users. Look Aheads allow users to
replace existing records add new records with the values chosen from Search & Select action
results or cells from the workbook. For example, a user can look up the account name when they
are adding a new opportunity to the app. You can design two types of Look Aheads:
Online: these lookups are real-time Salesforce data and are more flexible than offline. See
the procedure for details.
Offline: these lookups are for data that is already available in Excel (it might have been
placed there from any source). For example, from a data invoking action (Query or Search
and Select), data that was already in the template, or data that is generated from a macro
into a list and made available to the offline lookup feature.

Prerequisite
Before creating a field lookup, you must have an existing field mapping in a Display or
Save Map.

225

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

To create an online lookup
A Search and Select Action on the object that corresponds to the lookup value field must exist. For
example, if you need an account lookup, there must be a Search and Select Action on the Account
object.
1. Click Display Map.
2. Select a Display Map and click Edit. The Display Map panel opens.
3. In the Mapped Details section of the Display Map pane, click the magnify icon

to open

lookup properties for that field.
4. Click the Search And Select Action tab.
5. Select the applicable Search and Select Action.
6. To set Online Lookup as the default lookup method, select the Is Active check box. Either

Offline or Online lookup can be active at a given time. To provide an online lookup when the
user is online and an offline lookup when the user is offline, create both types of lookups and
select the Is Active check box in the online lookup.
7. In the Mapped Record ID field, select the record ID field and click Save.

This ensures that the correct lookup will be returned to the record. To remove an existing
Online Lookup, click Remove.
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8. Click Close.

To create an online lookup where new rows are added for each record
selected in the lookup
The Enable Field Mapping check box allows you to design a lookup where the data is fetched from
the Search and Select Action. The check box also enables you to add new rows and data for each
record selected by the user in the record search.
1. Follow the steps to create an online lookup and also click Enable Field Mapping.
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2. For each field in the Search and Select Action, select a corresponding Target Field from the

Display Map.

The Enable Field Mapping check box in a look ahead dialog allows you to design a look
ahead where the data is fetched from the Search and Select Action. The check box
enables you to add or replace new rows and data for each record selected by the user in
the record search.
In the Result Selection of the Search and Select action, decide whether the user can
select a single or multiple results that are returned to Excel, and select a Result selection.
(You can only select Multiple for a List object.). You can set any of the following options:
Single: Replaces the selected record.
Multiple: Creates a new record.
228

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

To create an offline lookup for single column
1. Click Display Map.
2. Select a Display Map and click Edit. The Display Map panel opens.
3. In the Mapped Details section of the Display Map pane, click the magnify icon

to open

lookup properties for that field. The X-Author Designer window opens.

4. Click the Excel tab and from the Column Mapping section, select Single Column.

The single-column option must be used only when the list of values does not
contain duplicate lookup values because it returns only the lookup value. If there
are duplicates, the first value found in Salesforce is populated in the lookup field,
and that may not be the value intended by the user.
5. Enter the range representing the lookup values. This can be done in the following ways.

In New Range, type the single column cell range that contains the list of values to be
searched and click Save to save the data source.
Highlight the list values in the worksheet and click Get Current Selection.
6. To make offline lookup the default lookup method, select the Is Active check box. Either

Offline or Online can be active at a given time.
7. To provide an online lookup when the user is online and an offline lookup when the user is

offline, create both types of lookups and select the Is Active check box of online lookup.
When the user is online, the Online Lookup will be active. When the user goes offline, the
offline lookup will automatically become active.
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The first time a lookup is initiated by the end user, the lookup function loads data
from the worksheet and stores it in the Lookup window for quick results on
successive lookups. If you expect changes in lookup data, then refresh the lookup
fields every time you load the lookup by selecting the Refresh on Every Data
Loadcheck box.
8. Click Save.

To create an offline lookup for multiple columns
1. Click Display Map.
2. Select a Display Map and click Edit. The Display Map panel opens.
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3. In the Mapped Details section of the Display Map pane, click the magnify icon

to open

lookup properties for that field.

4. Click the Excel tab and, under the Column Mapping section, select Multi-Column.

Note
This is the preferred lookup option for offline lookups because it handles duplicate
lookup values correctly.
5. Enter the range representing the lookup values. This can be done in one of the following

ways.
In New Range, type the multicolumn cell range that has the list of values to be
searched and click Save to save the data source.
Highlight the list values in the worksheet and click Get Current Selection.
Your range must always include the record ID of the lookup value (for example, Account ID).
The column identifiers appear in the display columns.
6. Select the Primary Return Column. This is the column that matches the lookup value (for

example, Account Name).
7. Select the Secondary Return Column. This must always be the column that has the record

ID of the lookup value.
8. Select the Target Field. This must be the record ID field for the lookup name.
9. To make the Offline Lookup the default lookup method, click the Is Active check box.

Note: Either Offline or Online can be active at a given time.
10. To provide an online lookup when the user is online and offline lookup when the user is

offline, create both types of lookups and click the Is Active check box for online lookup.
When the user is online, online lookup will be active. When the user goes offline, the offline
lookup will automatically become active.
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11. The first time a lookup is initiated by the end user, the Lookup function loads data from the

worksheet and stores it in the Lookup window for quick results on successive lookups. If you
expect changes in lookup data, refresh the lookup fields every time you load the lookup by
clicking the Refresh on Every Data Load check box.

Mapping Records into Columns and Rows
Matrix maps extend the capabilities of X-Author for Excel well beyond the list format. In lists, one
Salesforce record is represented per Excel row or column. Using matrices, a record can be
represented by one or more cells by mapping columns and rows (the X and Y axes) of a matrix as
well as the data contained in the cell at the intersection of the mapped column and row. Depending
on the design, some matrix cells may be updatable by a user. If no value exists in that cell, adding
a value can create a new record depending on the matrix design. The following table describes the
basic elements of Matrix Maps.
Term

Definition

Matrix

A matrix is any area comprised of one or more sections.

Section

A section is an area of the matrix that represents a single record. It can include one or
many row-column-data combinations. Every matrix has at least one section. Each
section can also have its own section filters.

Column
mapping

A column mapping is created when you drag a field to the worksheet from a List
object. The value in the cell can either be a static field label, a static field value, or a
dynamic field value.

Row
mapping

A row mapping is created when you drag a field to the worksheet from a List object.
The value in the cell can either be a static field label, a static field value, or a dynamic
field value.

Data
mapping

A data mapping is created when you drag a field to the worksheet from a List object.
It must be created after the column and row mappings are in place. Each data
mapping with its column and row mappings must be its own section or must be added
to an existing section.
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Term

Definition

Matrix
filters

Matrix filters are part of the data-getter actions and filter the data as it moves from
Salesforce into the matrix. Matrix filters can be displayed above the matrix or
elsewhere in the workbook.

A section is simply any combination of a column and/or a row and the associated data cells,
either with or without filters, that represents a single record.
A section may also be that same column-and-row-plus-data combination with the addition of
filters.
There can be an unlimited number of sections in a matrix and an unlimited number of
matrices in a worksheet.
The data values can be static or dynamic and can be either field names or field values from
one or more objects.
Filters can be applied to an entire matrix through both the Query action and the Search or
Select action, or they can be applied separately for each section.
Empty rows or columns, with or without formulas, can be added.
Data is saved via Save Maps which are associated with Sections, not fields.

Matrix Map Examples
The following examples illustrate some of the capabilities of matrices. The first example uses three
objects — Budgettrx, GLAccount, and FiscalYear. The objective is to retrieve the Amount field from
the Budgettrx object for all Marketing Accounts in the GLAccount object and for each Fiscal Period
in Fiscal Year 14.
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Each intersecting cell is one record from the BudgetTrx object.
The data is filtered for the entire matrix to return only Marketing Department data for
January 2014 – March 2014.
Both the X and Y values are dynamically generated based on “Marketing Department” and
FY 14 filters.
There is only one section in the matrix comprised of:
Y axis values using the AccountName field values in the GLAccount object.
X axis values using the FiscalPeriod field values from the FiscalYear object.
The XY intersection, which contains the Amount field from the BudgetTrx object.
The second example is a financial plan from a single object where the columns and rows are static
field values and the intersecting cell is the Amount field in that object.
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This matrix has multiple Sections because, even though the column, row, and intersecting cells
have the same field mappings throughout, the forecast and the actual records differ based on a
field that is not displayed on the matrix: the Type field. Therefore there are two sections and they
are distinguished by filtering the data for each section using the section filters.

Creating a Matrix
There is no precise order in which to create a matrix. However, following these steps in order will
provide better results.
1. Add your Salesforce Objects.
2. Decide how you are going to lay out the matrix, including formulas and empty rows and

columns.
3. Create your sections and add your empty rows and columns as you go.
4. If any cells are static, add the cell values at anytime.
5. Extend or copy your sections to fill out the matrix using the Extend function.
6. Add Section Filters.
7. Add Display Filters.
8. Add Save Maps.
9. Add actions, action flows, and ribbon menus.

Creating and Extending Sections
A section is an area of the matrix that represents a single record. It can include one or many rowcolumn-data combinations. Every matrix has at least one section. Each section can also have its
own section filters.
Creating Sections
Extending Sections
Grouping Data in Columns

Creating Sections
This procedure enables you to create a section
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To create sections
You must have at least one object selected in Salesforce Objects.
1. From the X-Author Designer ribbon, click Matrix Map.

2. Click Create.

The Matrix Map pane opens on the right side of Excel.
3. Type a Name for the Matrix Map.

If you are creating one Matrix Map, you can use Map or any other name. If you are using
multiple Matrix Maps, then you need a more descriptive name to identify each one.
Each object and its fields selected in Salesforce objects will be available for use in the Matrix
Map. Objects are listed based on the object behavior from Salesforce Objects (Ind and List).
List fields are displayed by default. You can switch to Individual fields using the Type list.
2364.
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4. Create a Row and Column Mapping for each section.
a. Drag a List field onto the worksheet. When you release the mouse, a pop-up window

appears.

b. Select either the Row or Column radio button. The Rendering Type, Value Type, and

Sort options are displayed. All of these work together to determine how row or column
values are populated.
c. Select a Rendering Type.

Static: This requires you to enter the cell value manually or X-Author uses the
Field Label.
Dynamic: Field data is retrieved automatically based on the data getter actions.
d. Select a Value Type.

If you select the Dynamic Rendering Type, this option is unavailable.
If you select Static from Rendering Type, this option becomes available with the
following options.
Field Label: Sometimes, the row or column label and the data value will use
the same field mapping. This occurs when you have multiple fields from the
same record in the section. This is a placeholder for the Designer to use the
Field Name as the row or column label. It is the one instance where the
intersecting value is determined from just the column or row mapping plus the
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data value. For example, if, for a single opportunity, you want to display three
fields—amount, volume, and average selling price—then, in the rows, the field
names would be described one on top of the other, and, in the data, you would
drag the field and the value of that field would be rendered.
Field Value: Enter the value of the field to be used in determining the data
value. If you look at the previous example, the field value would be either
Revenue or Cost of Revenue.
e. Click OK to complete the settings for that field.

5. Create Data Mappings for each section. Make sure that the cell you are mapping to is an

intersection of a row and column mapping.
a. Once you have created column and row mappings, you can drag and drop the field

that represents the intersection. When you drop the field, the pop up window will
appear and, in this case, the radio button will automatically default to Data. It uses the
closest row and column combination.
b. Enter a Section Name for the data or select an existing section name from the drop-

down menu.
c. Select a Row Lookup.
d. Select a Column Lookup.
e. Click OK.
6. Click Save and Close.
7. Click Save App.
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Extending Sections
Usually, a section will not only be used for a single cell (with its column and row mappings), but will
be used across a range of cells. To copy the properties of one section to other cells, designers can
use the Extend Section function (similar to the Excel format paintbrush function).

To extend a section
1. Click the Sections tab.
2. Select a section. The cells that comprise that section will be highlighted in the worksheet.

Make sure your cursor is in the worksheet data cell you want to copy.
3. Select the remainder of the range to extend to, including the data cell.
4. Click Extend Section in the pane to the right. The highlighted cells will expand and their

cells will be mapped on the Fields tab.
The selected section is extended.

Grouping Data in Columns
You can use matrix grouping features to display data in grouped columns within a matrix.
If you want to group pricing data for a region, for a specific devicetype for a particular processor,
configure the following
1. Set the Device Type field as a regular Dynamic Matrix Column.
2. Set the Region field as a Grouped Column on which the data is grouped.
3. Add Processor Name as Matrix Row.
4. Add Price as a Data Field to the Matrix.
5. You can add one or more grouped columns on top of the Region Grouped Column field.

Region (Grouped Column)
Device Type (Column)
Processor Name (Row)
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In this use case all the fields belong to the same object.While grouping data in columns ensure that
the fields belong to the same object or are associated with each other via a lookup.
For every Individual Matrix Column of Rendering Type – Dynamic, one or multiple grouped
columns may exist.
If the same record exists across multiple objects, you can group the data in the cells of a matrix
based on the objects the data exists in. For Matrix grouping to work, the data has to be structured
in such a way where the data for a particular field is common. Not every List can be transformed
into a matrix grouping use-case.
Matrix Grouping is applicable only on columns with Rendering Type as Dynamic. For matrix
grouping to work, there must be a valid Dynamic matrix column. A user can drag a matrix field on
top of an already created dynamic Matrix Column. X-Author for Excel automatically detects
whether a dragged matrix field is a matrix grouped field or not. If it is a grouped field, the Grouped
Field property is set to true automatically and within the elements of the matrix, the column
categorized as a Grouped Column.

To create Grouped Matrices
1. Click Matrix Map.
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2. Click Create.

The Matrix Map pane opens on the right side of Excel.
3. Type a Name for the Matrix Map.

If you are creating one Matrix Map, you can use Map or any other name. If you are using
multiple Matrix Maps, then you need a more descriptive name to identify each one.
Each object and its fields selected in Salesforce objects will be available for use in the Matrix
Map. Objects are listed based on the object behavior from Salesforce Objects (List). List
fields are displayed by default.
4. In an existing Matrix Map if you want to add a grouped column, create a Column Mapping for

each section.
a. Drag a List field onto the worksheet. When you release the mouse, a pop-up window

appears.

241

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

b. Click the Column radio button. The Rendering Type, Value Type, Grouped Field and

Sort options are displayed. All of these work together to determine how column values
are grouped.

Ensure that the Grouped Field column is True. If this field is set it to false, the
column added to the Matrix is not a part of other objects.
c. Select a Rendering Type.

Dynamic: Field data is retrieved automatically based on the data getter actions.
d. Click OK to complete the settings for that field.
5. Create Data Mappings for each section. Make sure that the cell you are mapping to is an

intersection of a row and column mapping.
a. After you have created column and row mappings, you can drag and drop the field that

represents the intersection. When you drop the field, the pop up window will appear
and, in this case, the radio button will automatically default to Data. It uses the closest
row and column combination.
b. Enter a Section Name for the data or select an existing section name from the drop-

down menu.
c. Select a Row Lookup.
d. Select a Column Lookup. Click OK to complete the settings for that field.
6. Click Save and Close.
7. Click Save App.
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Behavior of Grouped Matrices in Runtime
At runtime, the end-user doesn't need to do anything. Based on the matrix grouping design, the
data will be filtered from top most Grouped Column to last regular Matrix Column and finally the
data field is rendered.

Saving Matrix Grouping
If a Matrix contains Columns that are grouped, only the update operation can be performed. The
Insert operation cannot be performed.

Matrix Limitations
1. Currently grouping based on top of matrix columns is supported while grouping for matrix

rows is not supported.
2. If the data is grouped, you cannot add a row or a column to the matrix.

Creating Records
Depending on the type of matrix you create, a new record may be created when a user enters a
value in a mapped data cell that was previously blank.
Because of all the possible configuration variations, there is no absolute rule for record creation,
but there are some guidelines, assuming all required fields are ascertainable from the matrix,
matrix filters, and section filters.
Records will usually be able to be created when the following criteria are met.
Both the row and column mappings are lookups to other objects from the mapped data
object.
Column, row, or data mappings are all from the same object, and there are no other fields
on the matrix.
X-Author will use the following mappings and filters to create a new record:
Section Row
Section Column
Section Data
Static values identified as Equal To in the Section Filter
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Individual fields used as Matrix Filters

Creating Section Filters
There are two objectives for adding filters to a section.
To filter the data for that section.
To serve as the field value when a record is added in that section.

To add a section filter, you must have an existing Section.

To add a section filter
1. Click Matrix Map.
2. Select the desired Matrix Map and click Edit.
3. Click the Sections tab.
4. Click the lookup icon

next to a Section to open the filters window.

5. Add additional rows as needed. Refer to the Query Action section for information on adding

rows.
6. Click Save.
7. Click Save and click Close.
8. Click Save App.

Matrix Filters
Matrix data is filtered based on the Query action and the Search or Select action. To display any of
these filters, the fields must be mapped outside the matrix (usually above the matrix).

Displaying individual field filters
If you are using an individual field from another object as a filter, then use the Matrix Map Fields
tab to drag that field onto the worksheet. Matrix Map Individual fields have slightly different
behavior than Display Map fields because they cannot be updated. They are there for display
purposes only.
244 display a matrix filter
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To display a matrix filter
1. Click the Fields tab.
2. Select Individual as the Type.
3. Select a field and drag it onto the worksheet outside the matrix.
4. Click Save.
5. Click Save Application.

A matrix filter is displayed.

Working with Mapped Fields
Editing Mapped Fields
The Rendering Type, Field Type, and Sort Value can be changed by clicking the button in the Edit
column next to the field.

Viewing Sections
To see section layout, highlight a section in the Sections tab and the rows, columns, and data
mappings that comprise the section will be outlined.

Extending Sections
Usually, a section will not only be used for a single cell (with its column and row mappings), but will
be used across a range of cells. To copy the properties of one section to other cells, designers can
use the Extend Section function (similar to the Excel format paintbrush function).

To extend a section
1. Click the Sections tab.
2. Select a section. The cells that comprise that section will be highlighted in the worksheet.

Make sure your cursor is in the worksheet data cell you want to copy.
3. Select the remainder of the range to extend to, including the data cell.
4. Click Extend Section in the pane to the right. The highlighted cells will expand and their

cells will be mapped on the Fields tab.
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Uploading or Downloading File Attachments
You can upload and download file attachments using X-Author for Excel. For example, if you
create an app that uses Salesforce objects that contain attachments, such as the Opportunity
object, you can now download opportunity-related attachments from Salesforce and upload
attachments to Salesforce. All you need to do is add the attachments field to the Salesforce
Objects, the Display Map, and—if you are uploading attachments—the Save Map.
Downloaded files are located in %AppData%\Local\Temp\X-Author Attachments\[Object_ID]\,
where %AppData% is the location of the logged-in user's AppData directory in Windows (for
example, C:\Users\bdwyer\AppData) and Object_ID is a mashup of the name and the ID of the
object the attachment is associated with, such as an Opportunity. You can upload files from
anywhere on your workstation, though. To upload a file, you need to provide the full path to the
document and the document name as shown in the following example. If you are uploading
multiple attachments, separate them with a pipe ( | ) as shown in the following example.

In this example, the files will be uploaded to the Opportunity when you save the data to Salesforce.
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Launching an X-Author for Excel App from
Salesforce
From a button on any page in Salesforce, users can launch an App that opens in Excel and
automatically retrieves data from Salesforce. Depending on how this feature is configured, the flow
can vary, but is essentially as follows:
1. The X-Author user clicks a button on any Salesforce page (that can accommodate a button).
2. A new instance of Excel is opened and connects to Salesforce without any additional login

required by the user.
3. The App id specified in the button and (optionally) parent id are passed as parameters to the

App.
4. The App opens in Excel and executes the named or auto-execute Action Flow.

To implement this feature, perform the following steps in order.
1. Configure Launch from Salesforce using a custom button or Excel App setup.
2. Make your app launch-ready from Salesforce.
3. Add an External ID to action flow query actions.

Any app configured to launch from Salesforce must have at least one Action Flow to
execute when the app opens.

Configuring Launch from Salesforce
There are two ways to configure Launch from Salesforce by customizing the target (contextual)
object.
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Option 1: Create a custom button with a launch script
1. Go to Setup > Create > Object > Buttons, Links, and Actions. (for standard objects, go to

Customize > Object > Buttons Links, and Actions)
2. Click New Button or Link.
3. Enter the Label. Name is auto-populated.
4. Enter the Description of the button to help users understand the button.
5. Select a Display Type for the button.

Display
Type

Description

Detail
Link
Page

To display the custom button as a link

Detail
Page
Button

To display the custom button as a detail button. For example, to display the
custom button with Edit, Delete, Cancel, and Clone buttons.

List
Button

To display the custom button as a list button. For example, to display the
custom button with Merge Contacts, New, Add to Categories and so on.

6. Click the Behavior drop-down and select Execute JavaScript.
7. Click the Content Source and select OnClick JavaScript.
8. Enter the following JavaScript code in the Formula Editor:

Launch from Salesforce JavaScript Code (Customize)
{!REQUIRESCRIPT("/xdomain/xdomain.js")}
{!REQUIRESCRIPT("/soap/ajax/26.0/connection.js")}
{!REQUIRESCRIPT("/support/console/28.0/integration.js")}
var parentId = "{!Opportunity.Id}";
var hostUrl = "https://na16.salesforce.com";
var appId = "e4a933ff-6648-46ae-80b8-a4e66c6f7d29"
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var actionflowName = "TestActionFlow2"
var sessionId = '{!GETSESSIONID()}';

try {
sforce.connection.sessionId = "{!$Api.Session_ID}"; //t
o avoid session timeout
} catch(e) {
erroralert(cERROR_UNKNOWN,e);
}
var urlVal = ('xauthorforexcel:export '+ appId + ' ' + parentId
+ ' ' + sessionId + ' ' + hostUrl + ' ' + actionflowName);
window.top.location.href =urlVal;
Change the following in the above code to refer to your app and action flow:
parentId – id of the context object or related parent object where the button is placed.
hostURL– top domain name of the Salesforce URL
appId– App's unique id taken from any app record.
actionflowName– (Optional) Name of the action flow to execute when the App
launches.

We recommend the use of a named action flow (actionflowName) when the same
app with all its mappings needs to be launched from different object records. This
prevents the need to clone copies of the same app and helps in better
maintainability.
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9. Click Check Syntax to verify that no errors have been made in the script.
10. Click Save.

Option 2: Configure Excel App Setup
There is no limit to the number of different Apps that can be launched from Salesforce. It could be
a list of opportunities, or a list of opportunities or contacts for an account. You can place buttons
anywhere Salesforce allows them to be located. X-Author for Excel provides a few sample buttons.
To see an example, search for buttons from Salesforce Setup, then navigate to the Opportunity
buttons, and locate the Edit in Excel button.
1. Switch to the X-Author for Excel application from the Force.com App Menu or locate Apps

using the + on the menu.
2. Click the Apps tab.
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3. Click the Excel App Setup button from the Apps list view. You will see a list of example

Apps that come with the X-Author for Excel managed package.

Note
If the Excel App Setup button is not visible, you need to add it to your App page
layout. Refer to Completing Setup for Designers for instructions.
4. Enter a Name to describe the app you want to invoke (for example, if launching Contacts

from the Accounts page, "Accounts and Contacts").
5. Click the Application drop-down and select the App to launch.

Note
Only activated apps are displayed in the picklist. Also, remember that a user cannot
launch an app from Salesforce unless they have been assigned to the app.
6. Click Save.

To create the Edit in Excel button on any standard or custom object
1. Go to Setup > Build > Customize > Opportunities and select Buttons, Links and Actions

.
2. Click New Button or Link.
3. Enter the Label. Name is auto-populated.
4. Enter the Description of the button to help users understand the button.
5. Select a Display Type for the button.
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Display
Type

Description

Detail
Page
Button

To display the custom button as a detail button. For example, to display the
custom button with Edit, Delete, Cancel, and Clone buttons.

List
Button

To display the custom button as a list button. For example, to display the
custom button with Merge Contacts, New, Add to Categories and so on.

6. Select a Behavior. Click View Behavior Options to view the options of behavior.
7. Select Custom Source.
8. Enter the following code into the Formula Editor:

/apex/Apttus_XApps__EditInExcelLaunch?parentRecordId={!Account.
Id}&"&appName=3_8 AC_Opps ASC"
parentRecordId is the Id of the context object, and appName is the name of the App you
want to launch in Excel.
9. Click Save. Don't forget to add the Edit in Excel button to the Salesforce page.

Making an App Launch-Ready from Salesforce
An app needs an Action Flow to be specified to automatically run when the app is launched. There
are two ways to specify an Action Flow:
Named Action Flow (from Option 1, above). Enter the name of the Action Flow from the
App that you want to execute on launch by defining the actionflowName parameter. This is
recommended when the same app is required to be launched from different object records.
Auto-Execute configuration from the App (Option 1 or 2, above). From the X-Author for
Excel Designer ribbon in the app, click Action Flow. Click the check box for the correct
action flow under "Auto-Execute (Launch from Salesforce") and save the app. Only one
Action Flow can be selected.
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Adding an External ID to the Query
If this is an App that has no parent, such as a list of opportunities, make sure the query has the
appropriate hard coded filters to retrieve the records you want.
If this is a parent/child App, then the query requires a filter to identify the parent field. For example,
if the button is on the Opportunity related list for Accounts, then the Account Id is the parent id that
is passed as a parameter.

To add an External ID to a query
1. Open the query that is retrieving the data.
2. Add a filter as follows - this example uses Account/Opportunity but you should select the

parent id field in the object that looks up to the parent.

3. Click Save and Save App.
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X-Author for Excel Runtime Functions
The following runtime functions are available for X-Author for Excel apps.
Switch Connection
Opening Apps
Adding Rows or Records to a List
Adding Rows and Columns to a Matrix
Paste from Mapping
Deleting Records from Salesforce
Adding and Deleting Records
Chatter
Rich Text

Switch Connection
To connect to Salesforce from X-Author for Excel at Runtime
1. Click Connect to display the Manage Connections window.
2. Under the Create a new connection section and in the Name field, enter the Salesforce.com

user name.
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3. In the Login URL, add the URL. In many cases, the URL is login.salesforce.com for

production orgs and test.salesforce.com for sandboxes. You can click the shortcut for either
of these in Examples. For a custom URL, type the custom domain name.
4. Click Authorize.
5. Open an App.

Opening Apps
To open an App, you must be connected to your Salesforce org.

To open an app
1. Click Apps and then click Open Application to view the available Apps to open.

2. Either scroll down to find an App or enter in the App name in Search by Application Name

and click Search. Then either double-click on the App or click Select.

The My Apps check box is an App designer option only for testing apps.
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3. You can also select an App from the shortcut list.

After the App loads into Excel, you will see custom menus created specifically for the chosen app,
such as Retrieve Opportunities, as well as one or more of the X-Author for Excel standard buttons:
Add Row, Paste, Delete Row(s) from Salesforce, and Chatter.

Adding Rows or Records to a List
New rows or records can be added to a list in Excel in one of two ways: either by using the Add
Row button or by using one of the Paste functions from the Paste drop-down menu after you have
copied spreadsheet data.

To add a row or record
1. Click on the top part of Add Row to insert a single row or record.
2. Click on the bottom part of Add Row to insert more than one row.

There are three variations of the Paste function: Paste Values Only, Paste All, and Paste from
Mapping.
If you are copying data from another worksheet (same or different workbook), Paste eliminates the
need to use the Add Rows function. It automatically adds the exact number of rows and pastes the
data into those rows simultaneously.
1. Use the standard Excel copy function or Ctrl+C to copy data from the source.
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2. Click Paste > Paste Values Only to add rows and paste the data values.
3. Click Paste > Paste All to add rows and paste the data including formulas.

Adding Rows and Columns to a Matrix
Using the Add Matrix Row and Add Matrix Column buttons, you can add more data to your matrix.
However, there are specific rules you must follow. The only time you can add a column or a row is
when that row or column is defined with a Rendering Type of "Dynamic" and a Field Type of "Field
Value". If either the Rendering Type is set to Static, or the Field Type is set to Field Label, or both,
then you cannot add the row or column to the matrix at runtime. Click the link after the following
image to see all the possible combinations and which combinations allow you to add rows and
columns to matrices.

See all possible matrix combinations and whether or not you can add rows and columns
Matrix Configuration

Column: Static - Field Label
Row: Static - Field Label

Add
Row?

Add
Column?

NO

NO

#########Data########

NO

Column: Static - Field Value
NO
Row: Static - Field Label

#########Data########

YES

Column: Dynamic - Field Value
NO
Row: Static - Field Label
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Matrix Configuration

Add
Row?

Add
Column?
NO

Column: Static - Field Label
NO
Row: Static - Field Value

#########Data########

NO

Column: Static - Field Value
NO
Row: Static - Field Value

#########Data########

YES

Column: Dynamic - Field Value
NO
Row: Static - Field Value

#########Data########

NO

Column: Static - Field Label
YES
Row: Dynamic - Field Value

#########Data########

NO

Column: Static - Field Value
YES
Row: Dynamic - Field Value

#########Data########

Column: Dynamic - Field
Value
Row: Dynamic - Field Value

258

YES
YES

#########Data########

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

X-Author for Excel Designer and Runtime Guide Spring 2017 – Salesforce Platform

Paste from Mapping
This function is used during data migration between Salesforce orgs and is specifically for copying
data between source and target workbooks. Refer to Migrating Data Between Salesforce Orgs for
more details.
1. Open the Target App.
2. Click Paste > Paste from Mapping.
3. Select the source workbook file that contains the data to be copied and click Open.

Data is transferred from the source file to the Target App.

Deleting Records from Salesforce

To delete a row or multiple rows, select the row or consecutive rows and click Delete Row(s) from
Salesforce. X-Author for Excel will then ask you to confirm deletion of these rows. After you click
Yes, the records will be removed from Salesforce without any further save action or other user
action. The rows will also be removed from the worksheet.
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Adding and Deleting Records
Whenever a user right-clicks a cell, if the cell is a part of a Repeating range or is of type "Save
Field Only," then the X-Author add row menu and remove row menu is displayed in the context
menu. The native Insert or Delete function disappears. The Add or Remove menu is enabled.
The menu functionally behaves the same as Current Add Row menu.

Limitations of the Add Rows and Delete Rows functions
The user cannot access shortcut keys (Ctrl + and Ctrl -.) to insert or delete rows.

Chatter

This option opens a Salesforce Chatter feed in a separate window pane to the right of your Excel
workbook. It provides both the Chatter feed and various options to share all or parts of your
workbook directly into Chatter feeds. The X-Author for Chatter functionality requires both a
Salesforce Chatter license that provides API access and an X-Author for Chatter license. For more
detailed instructions, please refer to the X-Author for Chatter guide.
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Rich Text
If a rich text field has been included in a list, it will display as either Click here to Add or Click here
to Edit depending on whether that field already has data or not. When you click on a rich text field,
it will launch a side window that can be used to add or edit rich text. When you have completed the
rich text modifications for a record, click Save to Excel. When you are done with all other changes
to this or other records, then use the menu button provided in the template to save the data to
Salesforce.
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Enabling and Using Favorite Filters in
Queries
Favorite Filters allow runtime users to created preferred views by saving and reusing filters created
for executed Search & Select and Query actions. These Favorite Filters are unique to each user
and saved locally. Each app can have more than one Favorite Filter, and they can be used by the
same user across more than one app.

The examples shown in the following sections are for a Search & Select action–the same
filters can be created with a Query action requiring user input.

Enabling Favorite Filters
Designers can enable Favorite Filters when creating Search & Select or Query actions for any app.
To enable Favorite Filters for a specific action, create a new action or edit an existing one and click
the check box Enable Favorite Filters.

Using Favorite Filters
Runtime users can create and reuse Favorite Filters for any action in any app where the feature
was enabled by the designer. The option to create and use Favorite Filters appears when the
specified action executes as part of an action flow or when manually triggered. When a new
Favorite Filter is created by a user, it is stored locally on their system and made available as a
Favorite Filter for any enabled action for any app they use.
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Note
As Favorite Filters are saved locally by user, filters created by one user will not work on
the system of any other user.

To add a new Favorite Filter
When a Search & Select or Query action executes that requires input from the runtime user, and
Favorite Filters are enabled, the user can create a filter as normal and add it as a new, reusabled
filter.
1. Open an app and retrieve data that requires user input (Search & Select or Query screen).
2. From the action window, search for and filter the list of retrieved data.

3. Click on the Favorite Filter drop-down and select Add...

4. In the Add Filter dialog, enter a name for your Favorite Filter and click OK.
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5. Select the new filter from the drop-down. Your filter is now saved and can be reused for any

enabled action.

To use or reuse a Favorite Filter
1. Open an app and click on a user menu button to retrieve data that requires user input

(Search & Select or Query).
2. Click on the Favorite Filter drop-down and select a Favorite Filter from the list.

3. Execute the action.

To update a Favorite Filter
1. Open an app and click on a user menu button to retrieve data that requires user input

(Search & Select or Query).
2. Click on the Favorite Filter drop-down and select a Favorite Filter from the list.
3. Change the value or values of any filter for the action.
4. Click on the Favorite Filter drop-down and select Update.
2645.
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To remove a Favorite Filter
1. Open an app and click on a user menu button to retrieve data that requires user input

(Search & Select or Query).
2. Click on the Favorite Filter drop-down and select a Favorite Filter from the list.
3. Click on the Favorite Filter drop-down and select Remove.
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Configuring Presto Apps
The procedure below outlines the custom settings required to configure Presto Apps.
1. Go to Setup > Develop > Custom Setting. Look for DocGen System Properties. Click

Manage.
2. Under this setting one entry must be created - If there are no records then click New. After

clicking New, fill in the following details:
Name

System Properties

Merge Call Timeout
Millis

60,000

Merge Webservice
Endpoint

https://mergews.apttus.net/cgi-bin/MergeServer/Bin/MMCGI.exe
(Production)

3. Go to Setup > Develop > Custom Setting. Look for X-Author For Excel System Properties.

Click Manage.
4. Under this setting one entry needs to be created - If there are no records then click on New.

Fill in the details as shown in the table below:
Name

System Properties

Instance Url

<Instance Url for your Salesforce Org>
For example: https://na16.salesforce.com

If you see more fields under System Properties, keep them unchanged.
5. Go to Setup > Security Controls > Remote Site Settings.
6. Under this setting one entry needs to be created - if it doesn’t exist. Below are the details:
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Remote Site Name:

mergews

Remote Site URL:

https://mergews.apttus.net

Disable Protocol Security

Unchecked

Active

Yes

Configuring a Presto App
1. Create a new detail page button on your target object and configure the button setting as

shown in the illustration below:

Text for a Button or Link URL must be set. Copy the code below into the text area.

/apex/Apttus_XApps__EditInExcelLaunch?selectedRecordId={!
Account.Id}
&"&appName=Quote Calculator&mode=touchless&outputType=None"
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You can also set the information on a button, link or VF page by using the following
API in a class: Apttus_XApps.EditInExcelLaunchController editLaunch = new
Apttus_XApps.EditInExcelLaunchController('TestPresto2', recId,'XLSX'); where the
first parameter is the App name, second one is the record ID, and third one is the
output format. This API returns a boolean value. On successful execution, the API
returns true otherwise false.
To access the package for Presto as an API contact the Apttus Customer
Excellence by raising a case with them or Apttus Release Management Team.
2. Replace the following section of the code:

selectedRecordId is the record id of the object that will trigger X-Author for Excel. For
example if a button is created on the Account page, you will set the value as Account.Id.
appName is the name specified in Edit in Excel setup. This is NOT the actual name of the XAuthor for Excel app.
For example, as seen in the picture below, the appName will be Quote Calculator as
specified in Edit in Excel setup and NOT the actual name of X-Author for Excel app, which
in this case is SFDC - Quote Calculator.

outputType can either be None, EXCEL or PDF. When it is set as Excel or PDF, Presto will
attach the filled app template as an attachment to the selected record. The filename will be
Template.xlsx or Template.pdf when output type is Excel or PDF respectively.
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Apttus Copyright Disclaimer
Apttus Copyright Disclaimer

Copyright © 2017 Apttus Corporation (“Apttus”) and/or its affiliates. All rights reserved.
No part of this document, or any information linked to or referenced herein, may be
reproduced, distributed, or transmitted in any form or by any means, including photocopying,
recording, or other electronic or mechanical methods, without the prior written consent of
Apttus. All information contained herein is subject to change without notice and is not
warranted to be error free.
This document may describe certain features and functionality of software that Apttus makes
available for use under a license agreement containing restrictions on use and disclosure and
are protected by intellectual property laws. Except as expressly permitted in your license
agreement or allowed by law, you may not, in any form, or by any means, use, copy,
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish,
or display any part of the software. Reverse engineering, disassembly, decompilation of, or the
creation of derivative work(s) from, the software is strictly prohibited. Additionally, this
document may contain descriptions of software modules that are optional and for which you
may not have purchased a license. As a result, your specific software solution and/or
implementation may differ from those described in this document.
U.S. GOVERNMENT END USERS: Apttus software, including any operating system(s),
integrated software, any programs installed on the hardware, and/or documentation, delivered
to U.S. Government end users are “commercial computer software” pursuant to the applicable
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use,
duplication, disclosure, modification, and adaptation of the programs, including any operating
system, integrated software, any programs installed on the hardware, and/or documentation,
shall be subject to license terms and license restrictions applicable to the programs. No other
rights are granted to the U.S. Government.
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Neither the software nor the documentation were developed or intended for use in any
inherently dangerous applications, including applications that may create a risk of personal
injury. If you use this software or hardware in dangerous applications, then you shall be
responsible to take all appropriate fail-safe, backup, redundancy, and other measures to
ensure its safe use. Apttus and its affiliates disclaim any liability for any damages caused by
use of this software or hardware in dangerous applications.
Apttus and X-Author are registered trademarks of Apttus and/or its affiliates.
The documentation and/or software may provide links to Web sites and access to content,
products, and services from third parties. Apttus is not responsible for the availability of, or any
content provided by third parties. You bear all risks associated with the use of such content. If
you choose to purchase any products or services from a third party, the relationship is directly
between you and the third party. Apttus is not responsible for: (a) the quality of third-party
products or services; or (b) fulfilling any of the terms of the agreement with the third party,
including delivery of products or services and warranty obligations related to purchased
products or services. Apttus is not responsible for any loss or damage of any sort that you may
incur from dealing with any third party.
For additional resources and support, please visit https://apttusportal.force.com/community.

271

Copyright ©2011-2017 Apttus Corporation. All rights reserved.

